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Preface
This manual is designed to highlight the key features, setup procedures and general 
maintenance of the Handy PEA and Pocket PEA Chlorophyll Fluorimeters.

Document Conventions
If viewed electronically, blue highlighted text can be clicked in order to link to other parts of 
this document or to other documents and Internet locations. In order for the external links 
to be completed, an Internet connection must be established either via a standard or 
broadband dial-up modem or via a LAN (local area network) connection.

Notice
Instruments must not be used in situations where failure could result in injury or death.

For applications where failure of instrument to function correctly would lead to 
consequential damage, analysers must be checked for correct operation and calibration at 
intervals appropriate to the criticality of the situation.

This manual is provided to help you install and operate the equipment. Every effort has 
been made to ensure that the information contained in this manual is accurate and 
complete. Hansatech Instruments Ltd does not accept any liability for losses or damages 
resulting from the use of this information.

Hansatech Instruments Ltd equipment warranty is limited to replacement of defective 
components, and does not cover injury to persons or property or other consequential 
damage.

This manual, and the information contained in it, is copyright to Hansatech Instruments 
Ltd. No part of the manual may be copied, stored, transmitted or reproduced in any way or 
by any means including, but not limited to, photocopying, photography, magnetic or other 
mechanical or electrical means, without the prior written consent of Hansatech Instruments 
Ltd.

Handy PEA and Pocket PEA are covered under warranty for one complete year, parts and 
labour included. This, of course, is provided that the equipment is properly installed, 
operated and maintained in accordance with written instructions contained within this 
manual.

The warranty excludes all defects in equipment caused by incorrect installation, operation 
or maintenance, misuse, alteration, and/or accident.

If for some reason, a fault is covered under warranty, it is the responsibility of the customer 
to return the goods to Hansatech Instruments Ltd or an authorised agent for repair or 
replacement of the defective part(s). For service, please contact us at the address at the 
back of this manual.
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Chapter 1
Introduction to Chlorophyll 

Fluorescence



What is Chlorophyll Fluorescence?

When light energy from the sun is absorbed by a chlorophyll molecule within a sample, the 
electronic configuration of the molecule is temporarily altered. This excited configuration is 
inherently unstable and short lived (typically less than 10-8 sec) as several processes 
compete to dissipate the absorbed energy. In photosynthetic systems the processes by 
which this energy is dissipated are either photochemical or non-photochemical processes.

Photochemical processes utilise absorbed energy for photochemistry, during which 
electron donation from pigment to an acceptor molecule occurs. Such processes direct 
energy for the chemical work involved in photosynthesis.

Non-photochemical processes dissipate energy from the photosynthetic apparatus in a 
manner which does not drive photosynthesis. Energy is usually re-emitted from the sample 
in the form of infra-red radiation (heat) and red/far-red radiation which is known as 
chlorophyll fluorescence.
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The competition between these processes for absorbed energy ensures that a reduction in 
the rate of one process will be associated with a corresponding increase in the rates of 
competing processes e.g. a reduction in the dissipation of energy by photochemistry will 
be reflected in an increase in energy dissipation by non-photochemical processes such as 
heat production and chlorophyll fluorescence. 

Any forms of biotic or abiotic stress which have an effect on the photosynthetic 
performance of the sample e.g. effects the leaf’s ability to channel solar energy through 
the photochemical pathways, will therefore alter the intensity of the chlorophyll 
fluorescence emission. 

Consequently measurement of changes in the extent of fluorescence emission can be 
used to infer information about changes in the efficiency of light use for photochemistry 
(Reviewed in Krause and Weis 1991 and Govindjee 1995) and more significantly, using 
information gained from the measurement of the Fast Fluorescence or Kautsky Induction 
phenomenon (please see the Kautsky Fluorescence Induction section below), samples 
may be screened effectively for particular types of stress factors which limit the 
photosynthetic performance of the sample.

Since the work of Emerson et al. (1932) it has been widely accepted that there are two 
separate photochemical steps during photosynthesis which are associated with different 
groups of pigments; these groups have become known as photosystem I and photosystem 
II. In practice differences in the functionality of photosystem I and II mean that at least 95% 
of the chlorophyll fluorescence signal observed under physiological temperatures is 
derived from chlorophyll molecules associated with photosystem II (PSII).
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The Kautsky Fluorescence Induction.
If a sample is dark adapted the PSII electron acceptor pool is gradually re-oxidised to a
point where all of the PSII reaction centres are capable of undertaking photochemistry.
If that sample is then suddenly illuminated with a high intensity light source, a rapid 
(approx. 1 s) polyphasic rise in chlorophyll fluorescence may be observed which is 
subsequently followed by a slow (approx. 2 min) decline in fluorescence intensity to a 
steady state level of fluorescence. This induction phenomena is often referred to as the 
Kautsky Induction (H. Kautsky, A. Hirsch, Neue Versuche zur Kohlensäureassimilation, 
Naturwissenschaften, Volume 19, Issue 48, Nov 1931, Page 964). 

Kautsky Induction curves must be plotted on a logarithmic axis in order to observe the 
polyphasic rise to the maximum fluorescence value. This is due to the reactions causing 
the different kinetics occur typically in the first 300 msecs of illumination.

The kinetics of the induction curve appear universally in photosynthetic organisms 
including microalgae and cyanobacteria. It is therefore possible to label the individual 
elements of the fluorescence rise as shown in the graph above. The peaks are denoted by 
the letters O, J, I, P.

Fo (Fluorescence Origin) and Fm (Fluorescence Maximum) are parameters which have 
long been used in measurements of chlorophyll fluorescence. From these 2 absolute 
values, the parameter of Fv (Variable Fluorescence) may be calculated as the difference 
between the Fm and Fo levels. In turn, the Fm value may be displayed as a function of the 
Fv parameter in order to give the parameter Fv/Fm.

Fv/Fm has been used and widely accepted for many years as an indication of the 
maximum efficiency of Photosystem II. It is a highly effective and sensitive parameter 
which may be used as an indicator of sample stress. For further details, please refer to the 
Parameters Measured section.
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Parameters Measured.
Both Handy PEA and Pocket PEA are capable of recording the same parameters from a 
recording. Handy PEA offers an extremely flexible approach to the measurement process 
with the ability to define comprehensive protocols for multiple measurements with periods 
of dark adaptation or illumination before each recording stage.

Pocket PEA has reduced control over the measurement allowing only single 1, 3 or 10 
second recordings to be taken at a time. The following sections describe the parameters 
measured by the fluorimeters and the methods in which the parameters are derived.

The Fast Fluorescence Kinetic.

Chlorophyll fluorescence measurements are not absolute. The fluorescence emitted depends 
upon the light intensity and the response of the plant to the new light conditions. Many of the 
commonly used comparative fluorescence parameters are ratios. It is therefore important that 
measurements are made in truly comparable circumstances if data is to be used for 
comparison. The use of Handy PEA or Pocket PEA to make measurements is only one 
aspect of good experimental design and procedure.

If Fo and Fm cannot be determined accurately, all calculated values will be inaccurate.
The accurate determination of Fo depends upon instrument design. The measuring device 
should be capable of rapidly recording the fluorescence signal induced by illumination.
The Handy PEA and Pocket PEA both utilise a fast data acquisition system capable of 
recording every 10 microseconds. An algorithm is then used to determine a line of best fit 
through the data points recorded immediately after the start of illumination. This line is 
extrapolated back to time zero when illumination commenced in order to derive Fo. 

It is vitally important that the illumination should not vary in intensity during measurement 
otherwise the Fo and peak fluorescence will have been determined using different light levels 
and therefore cannot be compared. 

The illumination must also be at full measuring intensity before measurements commence, 
otherwise the early data points are  recorded at varying light intensities. This is the advantage 
of using LED’s as they almost instantaneously rise to full intensity when illuminated.

In order that the maximum fluorescence signal obtained can be regarded as Fm, the sample 
should be dark adapted and the light must be of sufficient intensity to saturate the plant, so 
that the addition of more light would not cause additional fluorescence. If the light is not of 
saturating intensity, the fluorescence will reach a peak value, but this peak will not be the 
maximum possible fluorescence signal (Fm) and should not be used for calculations of Fv/
Fm ratios.

Saturating intensities will vary from species to species, and with the period of dark adaptation 
and the environmental conditions in which the plant is growing. It is important to ensure that 
saturation is achieved by measuring at various light intensities after a range of dark 
adaptation periods to check that the Fv/Fm ratio cannot be increased by using higher light 
levels. Further information on dark adaptation and saturating light levels may be found in the 
Dark Adaptation of Samples section.
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General Parameters Recorded by the Fluorimeters.

The parameters within this category are calculated in relation to the minimum (Fo) and 
maximum (Fm) fluorescence values recorded from the sample.

 Fo.
The Fo parameter is thought to represent emission by excited chlorophyll a molecules in 
the antennae structure of Photosystem II. The true Fo level is only observed when the first 
stable electron acceptor of Photosystem II called Qa is fully oxidised. This requires 
thorough dark adaptation. Fo occurs at time base 0. It is the almost instantaneous 
(nanoseconds range) rise to an origin level of fluorescence upon illumination using the 
fluorimeter. Due to restrictions in electronics technology and the speed of fluorescence 
detection, it is not possible to measure the true Fo. However, it is possible to estimate the 
Fo level to a high degree of accuracy using a mathematical algorithm.

A line of best fit is calculated using least squares regression through the initial data points 
(4 - 16) recorded at the onset of illumination. This line of best fit is extrapolated to time 0 
(the start of illumination) to determine Fo. Provided the sample occupies the whole of the 
illuminated area of the clip and the sample is fully dark adapted, the value obtained for Fo 
of different specimens at the same light level may be used for comparison. 

The Summary Screen has an option allowing the F1 data point (recorded at 50 mseconds) 
to be used as the Fo parameter value. Please refer to the Fo Parameter Panel section for 
details as to why it may be necessary to use this option in some cases.
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 Fm.
This is the maximum fluorescence value obtained for a continuous light intensity. This 
parameter may only be termed as maximum fluorescence if the light intensity is fully 
saturating for the plant and the electron acceptor Qa is fully reduced. If the light intensity 
used for the recording is not sufficiently high, the plant may not be fully saturated in all 
circumstances. The peak fluorescence level (Fp) achieved in these circumstances would 
not be maximal and therefore should not be used as Fm. Consequently the ratio Fv/Fm 
would not be correct and the ratio would strictly be Fv/Fp with a reduced value. This was 
commonly the case in older instruments using lower intensities for excitation due to 
constraints in technology. Rapid advances in LED technology allow modern day analytical 
instrumentation to be designed to incorporate ultra-bright LED’s providing fully saturating 
light intensities in smaller, more manageable units.

In order to compare the absolute values of Fm the plant should be fully dark adapted and 
occupy the total 4mm diameter illuminated area of the leafclip. As the fluorescence signal 
is proportional to the excitation intensity it is important that comparisons are only made 
between measurements at the same intensity.

The Pocket PEA and Handy PEA fluorimeters calculate the Fm by grouping recorded data 
points into sets of 4 values which are then averaged (i.e. Data points 1, 2, 3, 4 are 
averaged, then points 2, 3, 4, 5 are averaged, then points 3, 4, 5, 6 etc.).

The set of 4 data points which produces the highest average fluorescence value is further 
analysed. The reported Fm value is the third data point in the set which yielded the highest 
average fluorescence reading. This averaging technique eliminates the possibility of an 
artificial Fm being reported due to signal noise.

 Fv.
The Fv parameter indicates the variable component of the recording and relates to the 
maximum capacity for photochemical quenching. It is calculated by subtracting the Fo 
value from the Fm value.

 Fv/Fm.
Fv/Fm is a parameter widely used to indicate the maximum quantum efficiency of 
Photosystem II. This parameter is widely considered to be a sensitive indication of plant 
photosynthetic performance with healthy samples typically achieving a maximum Fv/Fm 
value of approx. 0.85. Values lower than this will be observed if a sample has been 
exposed to some type of biotic or abiotic stress factor which has reduced the capacity for 
photochemical quenching of energy within PSII. Fv/Fm is presented as a ratio of variable 
fluorescence (Fv) over the maximum fluorescence value (Fm).

 Tfm.
Tfm is a parameter used to indicate the time at which the maximum fluorescence value 
(Fm) was reached. This parameter may be used to indicate sample stress which causes 
the Fm to be reached much earlier than expected. 

 Area.
The area above the fluorescence curve between Fo and Fm is proportional to the pool size 
of the electron acceptors Qa on the reducing side of Photosystem II. If electron transfer 
from the reaction centres to the quinone pool is blocked such as is the mode of action of 
the photosynthetically active herbicide DCMU, this area will be dramatically reduced. 
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The Area measurement is a very useful parameter as it highlights any change in the shape 
of the induction kinetic between Fo and Fm which would not be evident from the other 
parameters e.g. Fo, Fm, Fv/Fm which only express changes of amplitude of the extreme 
Fo and Fm. An example of its use would be following the time dependence of herbicide 
penetration into the leaf by following changes in the induction kinetic with time. 

Time Marks Parameters.

The PEA Plus software extracts fluorescence values from the recorded data at 5 pre-
defined Time Marks. The times are:

 T1= 50 microseconds. 
 T2= 100 microseconds. 
 T3= (K step) 300 microseconds. 
 T4 = (J step) 2 milliseconds.
 T5 = (I step) 30 milliseconds. 

PEA Plus uses the fluorescence values at these Time Marks to derive a series of further 
biophysical parameters, all referring to time base 0 (onset of fluorescence induction), that 
quantify the photosystem II behaviour for (A) The specific energy fluxes (per reaction 
centre) for:

 Absorption ( Abs/RC)
 Trapping (TRo/RC)
 Dissipation (DIo/CS)
 Electron transport (ETo/RC)

and (B) the flux ratios or yields:

 Maximum yield of primary photochemistry (jEo = TRo/ABS)
 Efficiency (Ψo=Eto/Tro) with which a trapped exciton can move an electron into the 
 electron transport chain further than QA-.
 Quantum yield of electron transport (Eto/CS). 

The concentration of active PSII reaction centres per excited cross section (RC/CS) is also 
calculated. 

Performance Index Parameters.

The Performance Index is essentially an indicator of sample vitality. It is an overall 
expression indicating a kind of internal force of the sample to resist constraints from 
outside. It is a Force in the same way that redox potential in a mixture of redox couples is 
a force. Exactly the PI is a force if used on log scale. Therefore we say:

log PI = Driving Force DF 

The PI or Performance Index is derived according to the Nernst equation. It is the equation 
which describes the forces of redox reactions and generally movements of Gibbs free 
Energy in biochemical systems. Such a force (or potential = force) is defined as:- 

Potential = log x/(1-x) 
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where x is the fraction of a partner in the reaction A to B. Therefore: 

X = A /(A + B) 
and if you now convert to:

X/(1-X) = A / B 
or for redox reactions 

log (red)/(ox) 

Now the total potential in a mixture is the sum of the individual potentials or:

Potential total = log X1/(1-X1) + log X2/(1-X2) ....,etc 

In our case PI (on an absorption basis or on a chlorophyll basis) has three components: 

 The first component shows the force due to the concentration of active reaction centers 

X1 = RC Chlorophyll per total chlorophyll = CHL(RC)/CHL(total) 

therefore: 

X1/(1-X1) = CHL(RC) / ( CHL(tot) - CHL(RC)) = CHL(RC) / CHL(antenna) = RC/ABS 

RC/ABS is a parameter of the JIP test and it is related to the force generated by the RC 
concentration per antenna chlorophyll. 

 The second component is the force of the light reactions, which is related to the 
quantum yield of primary photochemistry: 

PHI(Po) = maxTrapping / Absorption = TRo/ABS = Fv/Fm 

The Driving force of the light reactions is therefore: 

DF(PHI(Po)) = log PHI/(1 - PHI) = log (Fv/Fm) / ( 1 - Fv/Fm) = log Fv/Fo = log kP/kN 

 
 The third component is the force related to the dark reactions (after Qa-). These are 
normal redox reactions in the dark. 

Expressed by the JIP-test as:- 

psi(o) = ETo/TRo = (1 - Vj) 

Where Vj = relative variable fluorescence at 2 ms or at the step J therefore:

Vj = (Fj - Fo)/(Fm - Fo) and psi(o) = 1 - Vj = (Fm - Fj) / (Fm - Fo) 

Therefore the force of the dark reactions is: 

DF(psi) = log psi/(1-psi) = log (1-Vj)/Vj 

Now all three components together make:
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 DF (total on a chl basis) = DF(RC) + DF(phi) + DF(psi) 
or without log 

PI(abs) = RC/ABS * PHI/(1-PHI) * psi/(1-psi) 

or in fluorescence terms: 

PI(abs) = (Vj / (dV/dto))* Fv/Fm * (Fv/Fo) * (Fm-Fj)/(Fj-Fo) 

A more detailed derivation and explanation is beyond the scope of this manual. Further 
detailed information may be obtained from the following publications which are included as 
PDF documents installed with the PEA Plus program. They can be found in the 
Publications sub-directory of the PEA Plus installation directory. 

R.J. Strasser, A. Srivastava and M. Tsimilli-Michael
The fluorescence transient as a tool to characterize and screen photosynthetic samples.

Strasser, R.J., M. Tsimilli-Michael and Srivastava, A.
Analysis of the Fluorescence Transient.

Dark Adaptation of Samples.

The first step in the measurement process is to cover the sample area to be analysed, with a 
small, lightweight leafclip. 

The clip has a small shutter plate which should be closed over the leaf when the clip is 
attached so that light is excluded and dark adaptation takes place. The body of the clips are 
constructed from white plastic to minimise the effects of heat build-up on the leaf during the 
period when the clip is in place. The locating ring section of the clip which interfaces with the 
fluorimeter optical assembly is constructed from black plastic. This ensures that the 
measurement is unaffected when measuring during conditions of high ambient light intensity.

The leaf or needle rests on a foam pad whilst in the clip in order to minimise damage to the 
structure of the leaf. The shutter plate should be closed to exclude light from the sample 
during dark adaptation. 

During dark adaptation, all the reaction centres are fully oxidised and available for 
photochemistry and any fluorescence yield is quenched. This process takes a variable 
amount of time and depends upon plant species, light history prior to the dark transition and 
whether or not the plant is stressed. Typically, 15 - 20 minutes may be required to dark adapt 
effectively. In order to reduce waiting time before measurement, a number of leaves may be 
dark adapted simultaneously using several leafclips. Some users even make measurements 
at night, thus ensuring an adequate supply of readily dark adapted samples and zero waiting 
time! 
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The time required for dark adaptation may be determined experimentally by following the 
guidelines below:

 Place a leafclip on the sample and allow 5 minutes for dark adaptation.
 Using the fluorimeter, set to record for 1 second at full intensity (please refer to the  
 relevant section on either Setting Up the Handy PEA or Setting Up the Pocket PEA for 
 further details), make a measurement on the  sample.
 Make a note of the Fv/Fm value.
 Re-dark adapt the sample, this time for 10 minutes.
 Perform another measurement, again noting the Fv/Fm value.
 Repeat this procedure dark adapting the sample longer by an increment of 5 minutes 
 each time.
 When the Fv/Fm value does not increase any further, use the dark adaptation time where 
 the highest Fv/Fm result was observed as shown in the following table.

In this table, the highest Fv/Fm reading was observed at 15 minutes. Subsequent dark 
adaptation durations yielded no further increase in value. Therefore, using a dark adaptation 
period of 15 minutes would be sufficient to fully dark adapt this particular sample with no 
advantage being gained from allowing further time. 

Minimum Light Intensity.
Different samples will require different minimum light intensities in order to fully reduce all 
reaction centres in the measurement area. As a general rule, the highest available light 
intensity should be used in order to ensure the sample is fully saturated during 
measurement to achieve an accurate Fm value. This also ensures that an adequate level 
of fluorescence signal is available for detection by the fluorimeter (the fluorescence signal 
is directly proportional to the excitation light intensity i.e. Higher light intensity provides 
higher overall fluorescence signal allowing greater signal to noise ratio).
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Leafclip with shutter 
retracted showing 
sample illumination 
area

Shutter blade

Leafclip body

Locating ring

Leafclip placed on 
sample with shutter in 
closed position

Time (mins) 5 10 15 20 25 30

Fv/Fm 0.64 0.70 0.78 0.78 0.77 0.78



The following table shows how to determine the minimum light intensity that would be 
required to fully saturate the sample in question. 

Place 10 clips on leaves/needles of the species to be measured and leave in place with 
the shutter closed for at least the minimum dark adaptation period (please see the 
previous section for information how how to determine this duration). Make measurements 
at each clip at increasing light levels between 0 and 3500µmol m-2 s-1 (information on 
setting the light intensity can be found in the relevant sections for the Handy PEA and 
Pocket PEA).

The Fv/Fm ratio should plateau above the saturation point. An example would be as 
follows:- 

In the above table, the maximum Fv/Fm measurement is achieved at a light level of 
3000µmol m-2 s-1. It would therefore be recommended that this level would be the 
minimum light intensity used for measurement. 
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Light (µmol m-2 s-1) 500 1000 1500 2000 2500 3000 3500

Fv/Fm 0.56 0.62 0.70 0.76 0.81 0.82 0.82



Chapter 2
Handy PEA

Chlorophyll Fluorimeter



Components of the Handy PEA System.
Overview.

The following image highlights the main components supplied with a Handy PEA system.

A: Handy PEA Control Unit.
B: Handy PEA Sensor Head.
C: Leafclips (10 supplied with system).
D: Neck Lanyard. Connects to a clip on the underside of the control unit.

The following components are also supplied with the Handy PEA System but are not 
shown in the image above:

 12V DC battery charger and mains lead.
 PEA Plus software on mini CD. This disc includes all manuals in PDF format.
 RS232 serial cable.
 Field Reference Manual.
 Carrying bag for all components.

The following sections cover the main system components in greater detail.

Handy PEA Control Unit.

Structure & Function.

Handy PEA uses sophisticated microprocessor control for all instrument functions. The 
instrument is totally solid-state and contains no electromechanical assemblies or moving 
parts which may result in reliability issues in field conditions. 
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All the electronics are housed in a lightweight (565gms), compact (170 x 85 x 40mm) yet 
rugged plastic enclosure designed to minimise the possibility of damage in the field. A 
waterproof, tactile keypad allows selections and inputs to be made and a liquid crystal 
display module presents menu options and data. 

Power is provided by internal Ni-MH batteries which allow typically up to 1000 
measurements to be performed at approx. 120 measurements/hour for 8-9 hours. Once 
fully discharged, batteries require 2-3 hours recharge time in order to reach full capacity. 
When only 10% of charge remains in the batteries, a Low Battery warning appears on the 
LCD display screen. 

The fluorescence signal received by the sensor head during recording is digitised in the 
control unit using a fast Analogue/Digital converter. The fluorescence signal is digitised at 
different rates dependent upon the different phases of the induction kinetic. Initially, data is 
sampled at 10µs intervals for the first 300µseconds. This provides excellent time resolution 
of Fo and the initial rise kinetics. The time resolution of digitisation is then switched to 
slower acquisition rates as the kinetics of the fluorescence signal slow. This process 
provides excellent time resolution of the overall measurement whilst minimising the size of 
the data set and thus ensuring excellent memory capacity. The table below shows the time 
resolution of sampling. 

  

e.g. A 1 second duration recording will comprise: 30 + 27 + 27 + 27 + 9 = 120 data points 
A 300 second duration recording will comprise: 192 data points.

Keypad Layout.

Selections and inputs to PEA are made via a membrane keypad. A short audible bleep 
confirms the key press. A longer bleep indicates an invalid input or key press. Selections 
are made from a series of menu screens which are viewed on a liquid crystal display 
module. Please refer to the Menu Structure & Function section for further information on 
the Handy PEA menu screens. 
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We strongly advise against running the Handy PEA for prolonged periods once 
the Low Battery warning is observed. Should the battery become completely 

discharged, previously recorded and saved data will be irreversibly lost. 

Data should be downloaded to a PC as soon as is practicable after 
measurement. 

Number Of
Data Points Interval  Total Elapsed 

Time

30 10µs 300µs

27 100µs 3ms

27 1ms 30ms

27 10ms 300ms

27 100ms 3 secs

27 1 sec 30 secs

27 10 secs 300 secs



 

Descriptions of the features labeled in the diagram above are as follows: 

A: Power On/Off. Should the Handy PEA menu system lock up at any time, this power 
switch may be rendered unusable. In this event, a system reset switch may be accessed 
by a small hole on the underside of the instrument. Insertion of a paper clip into this hole 
will perform a system reset. 
B: Moves the option select cursor upwards through the menus. This key is also used to 
scroll upwards through the recorded data information screens. 
C: Reset button. Returns to the Main Menu screen from anywhere in the menu structure. 
D: Alpha-numeric keypad. These keys are used to input file ID's consisting of any 
combination of number and letter characters. Pressing the key once will input the 
corresponding numeric value whilst further key presses in rapid succession will scroll 
through the letters assigned to that particular key in the same manner as a cellular 
telephone keypad. 
E: OK button. Accepts the highlighted menu option. Also initiates a measurement if the 
cursor is highlighting the Measure menu option from the Main Menu. 
F: Escape button. Returns to the previous menu. 
G: Moves the option select cursor downwards through the menus. This key is also used to 
scroll downwards through the recorded data information screens. 
H: Battery is charging indication light. When light switches off, battery is fully charged. 
I: LCD display screen. 

Connections to the Handy PEA Control Unit.

Handy PEA consists of three different connections as listed below: 

A: Sensor Head connection. 
This connection provides necessary power to 
illuminate the LED array and relays fluorescence 
signals recorded from the photodiode back to the 
control unit. The inter-connecting cable terminates at 
both ends with a Category 5 shielded RJ-45 type 
connection and may easily be interchanged with 
cables of different lengths. 

B: Charger socket.  
Allows connection to 12V mains powered stabilised 
universal input charger. Charging duration from 10% 
battery to maximum charge is typically 2-3 hours. 
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C: RS232 Serial connection. 
9 pin D type female socket for bi-directional data transfer to and from the PC. This port is 
also used for connection of the Handy PEA SQS (Serial Quantum Sensor) for calibration 
of the sensor head (please refer to the Calibrating the Light Source section for details on 
the SQS). 

Handy PEA Sensor Head.

A: Control unit / sensor head connection cable (Category 5 Shielded Patch lead with     
RJ-45 type connectors). 
B: Remote trigger button. 
C: High intensity LED array (Centred on 650nm) with NIR short-pass filters. 
D: Photo sensor with Kopp Corning RG9 long-pass filter.  

The Handy PEA Sensor Head plugs into the main control box via a 1m cable and a 
Category 5 shielded RJ-45 type connection. The sensor locates over the leafclip so that 
daylight is excluded and held in place during measurement with the hand. The shutter 
plate in the leafclip can then be slid open to expose the dark adapted leaf ready for 
illumination and measurement by the sensor unit. A switch is located on the side of sensor 
unit which allows measurement to be initiated or aborted without the need to touch the 
keypad of the control box. This is particularly useful if measurements need to be made 
with one hand free. The sensor unit houses an optical assembly which provides powerful 
illumination of the leaf and detection of the consequent fluorescence signal. 

 
The graph opposite shows the spectral characteristics of the 
LED’s used in the Handy PEA sensor head. Sample 
illumination is provided by an array of 3 high intensity LED's 
which are focused via lenses onto the leaf surface to provide 
even illumination over the exposed area of leaf (4mm dia). 
These provide red light of a peak wavelength of 650nm, 
which is readily absorbed by the chloroplasts of the leaf. The 
Infrared content of the LED's is blocked by NIR filters. 

LED's have the advantage of being rugged, emitting low 
levels of heat, and of rising to full intensity very rapidly 
(typically microseconds) after being switched on. This feature 
eliminates the inaccuracies of Fo measurement and the 
constraints on speed and reliability associated with a shutter 
which is a necessary item in systems using filament lamps 
rather than LED's.  
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 An optical feedback circuit monitors and 
corrects changes in the output intensity of 
the LED's. These changes are caused by 
internal heat build up in the LED's. The 
circuit also compensates for intensity 
changes caused by variation in ambient 
temperature. 

The detector is a high performance Pin 
photodiode and associated amplifier 
circuit. The optical design and filtering 
ensure that it responds maximally to the 
longer wavelength fluorescence signal and 
blocks the reflected shorter wavelength 
LED light used as the source of 
illumination.  

Calibrating the Light Source.

The information in this section is describes the light source calibration procedure using the 
SQS (Serial Quantum Sensor). This item is designed specifically for the calibration 
purpose and interfaces directly with the Handy PEA. It can also be used as a stand alone 
light meter and as such is supplied with custom logging software for a Windows® PC. For 
further in formation on the SQS, please contact Hansatech Instruments Ltd at the address 
at the rear of this document. 

It is important to ensure that a sufficiently saturating level of light is used for a 
measurement in order to determine the correct maximal fluorescence signal (Fm). Light 
levels or PFD (Photo Flux Density) levels are defined on Handy PEA in calibrated units of 
µmols m-2 s-1. 

This measurement unit is derived from the number of photons in the 400 - 700nm PAR 
(Photosynthetically Active Radiation) waveband region on a unit surface (m-2) over a unit 
time (s-1). 

The Handy PEA light source is calibrated prior to leaving the manufacturer. However, the 
intensity of LED's decline gradually with age and use so it is therefore desirable to re-
calibrate the Handy PEA light source in order to maintain reproducibility of results (i.e. after 
a years use, defining 3500µmols m-2 s-1 as a measurement intensity may only give 
3350µmols m-2 s-1 actual output). For users in applied fields of research (i.e. nursery 
growth applications, wine producers etc.) with more than one instrument in use, it is crucial 
that all instruments are calibrated together to ensure that the data is comparable when all 
of the results from all of the instruments are compiled together. 

SQS connects to the Handy PEA RS232 port either directly (as shown in the image 
following) or via the Null Modem cable supplied. Please note that the null modem cable is 
different to the RS232 cable used to connect the Handy PEA to the PC. Null modem 
cables have a female 9 pin ‘D-type’ connector at both ends. RS232 cables have 1 male 
and 1 female termination. 
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Please note that the sensor head and control unit supplied 
are calibrated to each other. Using unmatched sensor heads 

and control units will invalidate any calibration settings.



The LED array within the Handy PEA sensor head is 
focused, using lenses, down to a 4mm diameter 
measurement area. This coincides with the 
measurement area of the leafclips and ensures that 
the maximum possible intensity is delivered from the 
LED array directly onto the sample surface. 

During calibration, this focused area is positioned, 
with the help of a locating collar, directly over the 
4mm diameter active area of SQS therefore providing 
an accurate representation of incident light received 
by the sample. 

The light source calibration factor is calculated from a simple 2 point 
reading of a high and low light intensities. The calibration routine itself 
is accessed by selecting the Calibrate Light option from the Configure 
menu screen to display the information as shown in the opposite 
image. Selecting Re-Calibrate from this screen will initiate a fully 
automated calibration routine. 

The light source is first switched on at the high intensity calibration point. This is used to 
determine the maximum light level that can be used. The LED's are illuminated for 10 
seconds before the calibration reading is taken. This ensures that the LED's have 
stabilised and that an accurate reading is taken by the SQS. The low intensity calibration 
point is also taken after a 10 second stabilisation period. At the end of the calibration 
routine, the old and new calibration figures are displayed. These new figures may then be 
either saved or disregarded. 

Once the light source has been calibrated, Calibration Expiry Warnings may be set in the 
Configure menu so that the user is prompted to re-calibrate the light source after a given 
time period. These warnings are displayed when the Handy PEA is initially powered up. 
The expiry periods can be set to either of the following: 

 Daily 
 Weekly 
 Monthly 
 Never 

When the light source calibration reaches the end of the validity period, the Handy PEA 
prompts for re-calibration when powered up. 

Handy PEA Battery Charger.

Handy PEA is powered by 3 internal rechargeable Nickel-metal Hydride (Ni-MH) batteries 
which allow typically up to 1000 measurements to be performed at approx. 120 
measurements/hour for 8-9 hours. Once fully discharged, batteries require 2-3 hours 
recharge time in order to reach full capacity. The Handy PEA is supplied with a 12V 
stabilised universal input mains powered battery charger which connects via the charger 
input on the rear of the instrument. When the Handy PEA is connected to the charger, the 
red Charging light at the bottom left corner of the front panel is illuminated. Handy PEA is 
fully charged when this light switches off. 
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Please note that the Handy PEA battery was fully charged when leaving the factory 
however, some discharge may have taken place whilst in transit. It is advisable to ensure 
that the battery is fully charged before first use. As the battery is Ni-MH, it is also important 
to discharge the battery as low as possible before recharging on the first few occasions. 
Failure to do this may shorten the life of the battery. Handy PEA will not allow 
measurements to be performed when the battery level is below 10%. At this point, a Low 
Battery Warning will be displayed on screen. It is at this stage when the instrument should 
be recharged.

Basic Handy PEA Operation.
Quick Start.

The purpose of this section is to illustrate Handy PEA operation in it’s most basic form by 
describing the processes required to configure the default protocol, perform a single 
measurement, view the details of the measurement and finally, to transfer the 
measurement to the PEA Plus software via an RS232 connection. Some of the guidelines 
in this section are repeated in greater detail later on in this document and links to those 
sections are included where appropriate. 

Before Starting........

The first thing that is required before any measurements take place is to ensure that the 
battery is fully charged. This is a common requirement with any Ni-MH battery. Failure to 
do this may reduce the life of the battery. In addition, ensure that the battery is almost fully 
discharged before recharging on the first few occasions. This will maximise the life of the 
battery.

At this point, it is also advisable to place one of the leafclips (10 supplied with the system) 
on the sample that is to be measured. Dark adaptation may take up to 20 minutes. Please 
refer to the Dark Adaptation of Samples section for full details. While the sample is dark 
adapting, the Handy PEA control unit may be configured for basic use.

Configuring Handy PEA for Basic Measurements.

Switch the Handy PEA on using the On/Off button on the keypad. The display will 
temporarily show the Handy PEA firmware version number before advancing to the Main 
Menu. 

Using the Down arrow key, move the screen cursor down to the System menu option and 
press the OK key. With the screen cursor adjacent to the Protocol     (D) line, press the OK 
button again. The Protocol selection screen displays the Default protocol title along with 
any user-defined protocols that have been uploaded to the instrument. Further information 
can be found in the Protocol Editor section.

Press OK to select the Default protocol. The settings of the default protocol may now be 
configured by moving the screen cursor to the required element of the protocol and 
pressing the OK key. The following elements may be edited:
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 • Duration. - This may be anything between 0.1 and 300 seconds. Using the     
   alphanumeric keypad, set this value to 001.0 S (1 second measurement). Press the 
   OK key to accept the changes.
 • Intensity. - Set this value to the maximum available for the system. This value is  
   indicated on the line below.
 • Gain. - This value may be anything between 0.4 (for samples with high chlorophyll  
   content) and 10.0. Leave the value at x01.0 for x1 gain.

Press the ESC key twice to return to the System Options menu. Move the screen cursor 
down to the Configure menu option and press the OK key.

In the Configure menu, move the screen cursor down to the Autosave option. If the 
highlighted text adjacent to the Autosave option reads No, press the OK key. The 
highlighted text will change to read Yes. If the Autosave text already reads Yes, do not 
change this option. Now move the screen cursor down to the ID entry menu option. If the 
highlighted text adjacent to this option reads Yes, press the OK key to change the text to 
read No.

Move the screen cursor to the More option and press the OK key. In the new set of 
options, ensure the Dark Offset is switched to Yes. Press the Reset key to return to the 
Main Menu. Further details on all of these configuration options is available from the 
Configure section.

Performing the Measurement.

Ensure the sensor head is correctly connected to the control unit according to the 
Connections to the Handy PEA Control Unit section. Assuming that sufficient time has 
elapsed to dark adapt the sample, carefully mate the sensor head and the leafclip locating 
ring (please refer to the Dark Adapting Samples section) and ensure that a snug fit is 
achieved by pushing the 2 components together gently. There should be no gaps that 
would allow light leakage to the detector. Slide the leafclip shutter blade into the open 
position (again, please refer to the Dark Adapting Samples section for full details). This 
exposes the dark adapted section of the sample to the LED array.

On the control unit, ensure the screen cursor is next to the Measure menu option and 
press either the Ok key or the remote trigger button on the side of the sensor head itself. 
The LCD display will change to indicate the measurement in progress. Once the 
measurement is complete, key fluorescence parameters are calculated and displayed on 
screen as show in the image below.

Press the down arrow key to display details of the 
measurement protocol use to take the measurement as 
shown in the following image.

Pressing the down arrow key again will show the first of 15 
screens listing all individually recorded data points and 
associated time base. The first screen is shown in the image 
below.
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Continue to press the down arrow key to view all the individual data 
points. Pressing the OK key will save the record and a further OK key 
press returns to the Main Menu.

Once the data file has been saved and the Main Menu is displayed on 
the LCD screen, move the screen cursor down to the PC Mode option 
and press the OK key. The LCD will indicate that PC Mode is active.

Transferring the Data to a PEA Plus.

Using the RS232 serial cable, connect the Handy PEA to an available serial port (or USB 
port using the HAN/USB Serial - RS232 adapter. Please see the A Word About 
Communications section) and make a note of the port number. For full details on 
connecting the Handy PEA to a PC and establishing a Serial connection, please refer to 
the Establishing an RS232 Connection section on the PEA Plus chapter of this document.

Once the connection has been made, run the PEA Plus software. From the Menu bar, 
open the Handy PEA drop down menu and select the Select COM Port option. From the 
dialogue that is displayed, choose the relevant COM port to which the Handy PEA is 
connected. Click OK to accept.

Open the Handy PEA drop down menu again and select the Download Recordings option. 
Select the required file range in the displayed dialogue and click OK to download the 
recording just performed. If the download has been successful, the Summary Screen will 
be displaying a single record. It is now possible to view this record in the various analysis 
screens of PEA Plus software. Please read the PEA Plus chapter of this document for full 
details on the methods of data analysis offered by PEA Plus software.

Handy PEA Menu System.
Menu Structure & Function.

Handy PEA is operated and configured via the selection of options from a menu system. 
When the instrument is initially powered up, the default menu is the Main Menu (ID #01. 
Please refer to the Screen ID References section for information.) 

The Main Menu consists of 4 options leading through 4 different pathways of functionality: 

 Measurement.
The measurement activation pathway is entered by selecting the Measure option from the 
Main Menu (or by pressing the remote trigger button at the side of the Sensor Head). 
There are several permutations of screens that are displayed depending on the options 
that have been selected from the System configuration menus such as the ability to 
perform an Autogain function prior to a recording (please refer to the Autogain section for 
further details) and the option to assign an ID reference of up to 6 alpha-numeric 
characters to each record. Once any pre-recording functions have been performed, the 
measurement will initiate according to any protocol or measurement options that have 
been configured in the Protocols menu (please see the Protocols section for information). 
Once the measurement has completed, key fluorescence parameters are calculated and 
displayed on a series of screens along with individual recorded data points. Recordings 
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are then saved automatically to the Handy PEA memory either automatically or from a key 
press depending on whether the Autosave function on the Handy PEA is enabled (please 
see the Autosave section for details).

 File options. 
The file options pathway is accessed by selecting Files' from the Main Menu. Within the 
files pathway, options exist in order to allow the user to search for previously saved data 
files by file number or assigned ID reference and to delete all or a selection of previously 
saved data files. 

Selecting the View File option from the File Options menu allows individual files to be 
loaded from memory. Files are selected for viewing by either entering a known file number 
or by scrolling through saved files in numerical order by selecting either Next or Previous 
options. Searches may also be performed for individual or groups of records with 
corresponding ID reference (if assigned) by selecting the Search by ID function from the 
File Options menu. Both these options allow key fluorescence parameters, recording 
details and individual data points to be viewed.

 PC Mode.
This function must be engaged when serial communications between Handy PEA and a 
PC are required. 

 System Options.
The System Options pathway contains 4 sub-menus. 
  
Protocol.
In the System Options menu screen, the Protocol sub menu option is displayed with an 
adjacent bracketed character which will read either (D) or a number between (1) and (5). 
This character refers to the active protocol slot number (D refers to default protocol). It is 
this protocol which will be used when a measurement is activated.

The Protocol selection menu itself shows the titles of the protocols 
currently held in the Handy PEA memory. The default protocol is at 
the top of the screen and cannot be deleted. Further slots display 
Empty if no protocol inhabits that slot.

Only the Default protocol may be edited on the Handy PEA. 
Amendments to uploaded protocols must be made in the PEA Plus 
software Protocol Editor and re-uploaded to the Handy PEA (please 

refer to the Protocol Editor section of the PEA Plus chapter). All aspects of the Default 
protocol may be edited including recording duration, light intensity and instrument gain. To 
edit one of the protocol elements, move the cursor adjacent to the relevant item and press 
the OK button. Type the new value using the alphanumeric keypad followed by the OK 
button to accept the changes. Pressing the Esc key will select the protocol for use and 
return to the Protocol selection menu. Pressing the Reset button selects the protocol for 
use and returns to the Main Menu ready for measurement to begin.
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User-defined protocols are configured for use by moving the cursor 
adjacent to the required protocol title in the Protocol Selection menu 
and pressing the OK button on the keypad. Full details of the defined 
protocol including number of recordings (flashes) per protocol 
execution, pre-illumination details, individual recording duration and 
intensity, instrument gain and protocol repeat settings. These 
elements may not be edited on the Handy PEA itself.

Configure.
Configuration settings for the Handy PEA system are accessed through this pathway. 
Handy PEA has 9 options across 2 Configuration menu screens that affect the 
measurement process of Handy PEA. 

  

The configuration menu screens allow the following Handy PEA settings to be defined:

 Calibrate Light. 
Light source calibration may be performed at any time using the SQS Serial Quantum 
Sensor which is available as an additional item from Hansatech Instruments Ltd. Please 
refer to the Calibrating the Light Source section for further information.

 Autosave. 
The Autosave function can be toggled on and off by pressing the OK button adjacent to 
this menu option. The operational status of this feature is indicated on the same line. 
When enabled, recordings are automatically saved to memory after the parameters and 
individual data points have been displayed post measurement. With the Autosave function 
off, Handy PEA will display a Save File? message with a Yes' and No option after each 
measurement. 

Please note that the Autosave is automatically engaged when using protocols containing 
multiple recordings. This is due to key timing issues when using more complex protocols 
with multiple flashes and pre-illumination periods of a defined duration. 

 Autogain. 
This function is intended to maximise the signal sizes during measurement whilst ensuring 
that samples do not overscale the instrument. The Autogain function performs a very brief 
(µsec) measurement in order to determine the likely size of the Fo signal level for the 
given light intensity. A level of gain is automatically selected which ensures maximisation 
of signal levels but also ensuring that the Fm signal level will remain within the upper 
range of the instrument. Handy PEA readjusts the gain according to the measured signal 
i.e. a low fluorescence value will result in a higher instrument gain setting. Please note that 
the Autogain function has no effect over dark adaptation of the sample and of the main 
fluorescence induction measurement. 
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Autogain may also be configured in experimental protocols so that an instrument gain is 
re-established for every measurement. During protocols consisting of multiple flashes, the 
Autogain will only be performed prior to the first measurement. 

 ID Entry. 
The ID Entry feature provides a method of further identifying a file or group of files saved in 
the Handy PEA memory. For example: Files 1-45 saved in memory were all taken from 
different leaves on a single plant. These 45 files may all have ID numbers of PLANT1. 
Files 46-90 were all taken from leaves on a different plant and may be saved with a file ID 
of PLANT2 in order to differentiate the two sets of files stored in memory.  

The file ID number consists of up to 6 alpha or numeric characters and is entered before 
the measurement takes place. The ID number is displayed in all numerical Data Analysis 
Screens in PEA Plus software once the data has been uploaded to the PC. This allows 
data files to be easily arranged into individual Data Sets for more efficient analysis. Please 
refer to the Data Sets section of the PEA Plus chapter for further information on Data Sets.

PEA Plus software will allow the user to perform a search on File ID's e.g. In the above 
example, a search on PLANT2 will result in all records with the corresponding ID reference  
being highlighted. Files saved with ID numbers may also be located within the instrument 
memory by using the Search for ID function which is located in the File Options menu. 

Please note that file ID number may only be entered prior to every recording when 
performing single recordings. When using protocols containing multiple recordings, the ID 
reference is entered prior to the first recording. This ID is then assigned to all other 
recordings within the protocol. This is due to key timing issues when using more complex 
protocols with multiple flashes and pre-illumination periods of a defined duration. Should 
different ID references be required for individual recordings within a protocol, these may be 
edited from within the PEA Plus software using the Edit ID function in the Edit drop down 
menu.

 Averaging. 
This function uses Finite Impulse Response (FIR) digital signal processing techniques to 
smooth the data. For normal Fluorescence measurements it is not necessary to average 
but there is also no disadvantage. It is primarily intended for use with samples of lower 
chlorophyll concentration where signal to noise factors may become a factor. Sporadic 
high or low noise related data points will be ‘smoothed’ out eliminating the chance of 
incorrect parameter calculation.

 Dark Offset. 
All photodetectors generate a small signal (dark current) even in the absence of light. This 
signal is a measurement artefact and will vary in magnitude with ambient temperature. The 
dark current is automatically offset to zero when the Dark Offset function is switched to On. 
This function is particularly important for samples with low chlorophyll content where any 
measurement artefact may constitute a significant proportion of the measured signal. 

 Power Off. 
Changes the Auto Power Off time from 5 minutes to either 10 minutes, 30 minutes, 1 hour 
or never. 
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 Warnings 
Occasionally, users may be experience circumstances where the measured signal may be 
outside of the operating range of Handy PEA. If unexpected values are detected during 
measurement, those values will be flagged as Measurement Errors. One or more of the 
following error messages may be displayed.

WARN : Fm High - The value for Fm exceeds 4090 bits. 
WARN : Fm Low - The value for Fm is less than 500 bits. 
WARN : Fv/Fm High - The value of Fv/Fm is greater than 0.90. 
WARN : Fv/Fm Low - The value of Fv/Fm is less than 0.15. 
WARN : High Dark Offset - Dark Offset value divided by Gain setting 
is greater than 20 (DARK OFFSET/GAIN > 20) 

In most cases, there will be a simple explanation for the display of error messages e.g. the 
shutter blade of the leafclip was not properly open or the sample was not properly dark 
adapted. However there may be cases, for example, when the leaf is particularly unhealthy 
due to severe heat and drought environmental conditions and therefore yields a low Fv/Fm 
measurement. Even though the warning WARN : Fv/Fm Low is displayed, the parameters 
may be of importance to the study. Although the calculated parameters will show as errors, 
all raw data is still available and may be saved as normal. 

The Warnings menu option allows the warning messages to be disabled.

 Calib. Warn 
The Calib. Warn configuration menu option allows the validity period of any light source 
calibration settings to be defined. Please refer to the Calibrating the Light Source section 
for further information.

Info.
The System Information screen displays all details regarding the 
current status of the Handy PEA.  

• Files Free. - Handy PEA memory is able to store up to 1000 files of 
any measurement duration. This line shows the remaining available 
file count. 
• Last File. - This line shows the number of the last record to be saved 
in memory. 

 • Battery Level. - The Handy PEA is powered by 3 Nickel-Metal Hydride (Ni-MH)  
   rechargeable batteries providing approx. 8-9 hours continuous measurement. A Low 
   Battery warning is displayed onscreen when the battery level reaches 10%. We  
   recommend extremely minimal use after this warning is observed as running the  
   battery completely flat will result in loss of data from memory. 
 • Gain. - Shows the current gain setting of the instrument. 
 • Time and Date. - The time and date may be set from the Synchronise Date & Time  
   function in the PEA Plus software. Please refer to the Handy PEA drop down menu  
   section in the PEA Plus chapter for details on how to perform this function.
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Show Light Meter.
With the SQS Serial Quantum sensor connected to the Handy PEA, it is possible to test 
the output of the light source. Place the sensor head on to the SQS using the supplied 
locating collar and press the OK button on the keypad. This allows the light intensity to be 
set to the any value up to the maximum available. 

In addition, when connected to the Handy PEA, the SQS may also be used in order to 
obtain a reading of ambient PAR levels. Remove the locating collar from the SQS ensuring 
that no shading of the sensor occurs. The SQS is fully cosine corrected. 

Menu Navigation via Screen ID.
Navigation through the Handy PEA menu structure is also possible using the screen ID 
number system. All individual menu and information screens have unique reference 
numbers in the top right corner of the screen which may be used in order to access 
corresponding menu screens directly. For example, to navigate to the Protocol Selection 
menu screen, the conventional sequence of menu selections would be (from the Main 
Menu), System > Protocol. The Protocol Selection menu has a screen reference number 
of 12. Typing 12 on the keypad followed by the OK button will directly navigate to the 
Protocol Selection menu from any other menu location. The following table is a list of the 
menu screens within the menu structure and their corresponding ID reference numbers for 
direct access: 

The Reset and Esc buttons also perform navigation functions. Reset displays the Main 
Menu from whatever screen is currently in view whilst Esc returns to the previous menu.  
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Menu Screen Direct Access ID

Main Menu 1

File Options 2

System Options 3

Select File
(view file function) 4

Search for ID 5

Delete Files 6

Configure 7

Configure 8

PC Mode 9

Delete Files
(enter file numbers to delete) 10

Clear Memory
(data files only) 11

Protocol Selection 12

Current Light 
Calibration Settings 13

PAR Meter 14

System Information 15



Hardware Diagnostic Tools.
The Handy PEA features a hidden menu screen providing the ability to perform diagnostic 
tests on the different components of the Handy PEA control unit and sensor head. This 
menu is accessed by pressing: 1 > 2 > 3 > OK  in succession on the keypad. 2 menu 
options are available.

Hardware Tests.

LCD Test. 
The LCD Test displays a series of patterns and flashes in order to check for damaged 
pixels. Should any of the LCD pixels be faulty, please contact Hansatech Instruments for 
further information. 

Keypad Test. 
The Keypad Test provides a simple tool in order to ensure that the keypad is functioning 
normally. Press each key in turn. The display will show how the key has been read. If a 
key responds incorrectly or fails to respond at all, please contact Hansatech Instruments. 

LED Test. 
The LED Test provides a simple tool in order to ensure that the control unit is 
communicating with the sensor head correctly and also that the LED array is functioning 
normally. The LED Test screen consists of a series of 4 options. 

1: 0% Light 
2: 30% Light - Illuminates the LED's at 30% of max. intensity (approx. 1000 µmol m-2 s-1). 
3: 60% Light - Illuminates the LED's at 60% of max. intensity (approx. 2000 µmol m-2 s-1). 
4: 100% - Illuminates the LED's at the maximum intensity (approx. 3000 µmol m-2 s-1). 

The option is initiated by pressing the corresponding number key. If the LED's do not 
illuminate as expected, please contact Hansatech Instruments. 

Memory Test. 

During the test the memory is first loaded with a pattern of values. The memory is then 
read to confirm that the expected pattern of values is present. If the memory is functioning 
correctly the message TEST PASS will be shown. If not the faulty memory location will be 
shown. Please contact Hansatech Instruments with this information. 

Functional Tests. 

Detector Output. 
This requires the sensor unit to be connected to the control box. Select the Offset test. The 
display should show a voltage which will increase or decrease according to the amount of 
ambient light level. Shade the sensor with the palm of the hand and check the voltage 
reduces. This indicates that the Photodiode and circuitry of the sensor unit are correctly 
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Before performing memory tests be sure that all required 
data has been transferred to the Handy PEA software as the 
contents of the memory will be overwritten during this test.



operating. If the control box continues to give all zero data the A/D converter is likely to be 
faulty. Please contact Hansatech Instruments if the Handy-PEA fails this test. 

Different amounts of gain may also be applied to the input signal by pressing: 
0 - Gain 0.4 
1 - Gain 1.0 
2 - Gain 10.0 

Place the sensor unit on the bench to exclude light, the value should now go to between 0 
and 100 mV dependant on ambient temperature. All photodiodes give a small current 
output even when in the dark. This is known as the dark current which varies with ambient 
temperature. The Handy PEA may be configured to subtract this dark current from each 
measurement by switching the Dark Offset function to On in the Configure menu screen. 

Loopback Test. 

Load Test File. 

Before activating this function, it is necessary to completely erase the memory of the 
Handy PEA from the Memory Test function in the Hardware Tests menu. This function 
loads a test file with known data values into the Handy-PEA memory. The test file may be 
viewed as per other recorded data and may also be downloaded to PEA Plus software.

System Reset Methods.

LCD Display Lockup.
In the event of a system crash resulting in the LCD display freezing, it is possible to reset 
the Handy PEA using the Reset Button on the underside of the control unit. A narrow 
implement such as a paperclip will be required to activate the reset button. An activation, 
the Handy PEA control unit will power down. Switching the Handy PEA on again from the 
On/Off keypad button should power the unit up correctly. If functionality is not restored, 
please contact Hansatech Instruments for advice.

Data Download Problems.
Occasionally, data files in the Handy PEA memory may become corrupted. This issue is 
usually indicated by problems transferring all data files to PEA Plus. Should this occur, 
attempting to download data files in small groups will allow the large majority of records to 
be downloaded and possibly even the identification of the corrupted measurements. When 
as many measurements as possible have been downloaded to a PC and saved, it is 
necessary to perform a full factory restore on the control unit.

With the Handy PEA powered off, hold down keys 1 and 8 while simultaneously switching 
the control unit on. The Handy PEA will emit a double beep sound and display a Reset 
Complete message on the screen. Switch the Handy PEA off and on again to continue 
use.

34

The Loopback Test requires additional test equipment and 
should only be carried out by Hanstech Instruments Ltd.

Please note that performing a full factory restore will 
completely erase any files, protocols and settings in the 
control unit. The light source calibration will however, 

remain valid.



Chapter 3
Pocket PEA

Chlorophyll Fluorimeter



Using the Pocket PEA.
System Overview.

The image below shows the key features of the Pocket PEA control unit. The Pocket PEA 
control unit features a control unit and sensor in a single, ultra-portable handheld 
enclosure. A belt clip on the rear of the unit allows the Pocket PEA to be held securely 
when not in use.

Also provided with the Pocket PEA are:

 20 Dark adaptation leafclips.
 12V DC charger and mains lead.
 Software for Windows PC and PDA/IPAQ 
 running Windows Mobile 5.0.
 Carrying bag.

The LCD Display.

When in standby mode, the LCD display shows information regarding the current status of 
the Pocket PEA control unit as shown in the diagram above. Once a measurement is 
initiated, the LCD indicates that a recording is taking place and displays the illumination 
intensity. Fv/Fm and PI (Performance Index) parameter values are automatically calculated 
and displayed for 5 seconds once the measurement has completed before returning to 
standby mode.
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Pocket PEA Optical Interface.

The Pocket PEA optical interface is mounted directly on to the front of the Pocket PEA 
control unit. It consists of a single high intensity focused LED which is positioned vertically 
above the sample. The light emitted from the LED is filtered using an NIR filter to block any 
infra red content which could be seen by the detector (this is known as optical breakthrough). 
The fluorescence detector is fitted with an RG9 filter to further eliminate the chance of optical 
breakthrough. 

A highly sensitive PIN photodiode is used for detection of the fluorescence emission. The 
optical assembly is sealed behind a clear glass window which creates a barrier against 
moisture and dirt which are inherent problems for field based instruments.

The single LED provides up to 3500 µmols m-2 s-1 intensity with a peak wavelength of 627nm. 
The graph below shows the spectral output vs. relative intensity of the LED.

Configuring the Pocket PEA for Measurement.

The Pocket PEA is intended as an easy to use, rapid screening tool. As such, configuration 
options are limited to light source intensity between 0 and 3500 µmols m-2 s-1 and 
measurement duration of 1, 3 or 10 seconds. Both of these factors are configured from the 
PEA Plus or PEA Plus Mobile software packages and are explained fully in the relevant 
sections section.
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The only configuration function available from the Pocket PEA control unit itself is the ability 
to delete all file from memory. To perform a file delete, with the Pocket PEA switched OFF, 
hold down the Measure key and switch the control unit on using the Power on/off key. The 
screen will display the text “Measure to Erase All”. Pressing the Measure key will erase all file 
in memory.

Setting Up Bluetooth Communications.

Once data has been recorded by the Pocket PEA, it must be downloaded to either a PC or 
pocket PC (PDA) via Bluetooth Wireless Communications. Most modern laptop and 
desktop PC’s are now supplied with integral Bluetooth capability. Computers that do not 
have this capability built in will require the use of a plug-in USB Bluetooth module which 
are readily available from local computer retailers and also from online sources.

The setup procedure for Bluetooth modules will vary slightly between different modules 
from different sources. The relevant manufacturers installation procedure must be followed 
in order to correctly establish a Bluetooth Wireless connection. 

Once the Bluetooth module has been correctly installed, follow the module manufacturers 
advice on connecting to an external Bluetooth device. During this procedure, you will be 
asked to enter a PIN code. This code is programmed into the Pocket PEA and is displayed 
when the instrument is switched on. The code is different for each Pocket PEA instrument 
and is required by the Bluetooth module if communications are to be established. Once a 
Bluetooth serial link has been established between the Pocket PEA and the PC, open the 
properties of the link and make a note of the COMM port number being used by the PC for 
communications. This port number will be required by the PEA Plus software.

Performing a Measurement.

 Ensure that the Pocket PEA is switched on using the On/Off button. The display will show 
 a Ready status message indicating that a measurement may be taken.
 Ensure that the sample to be measured has been fully dark adapted using the leafclips as 
 described in the Dark Adapting Samples section in the Introduction chapter.
 Mate the optical assembly of Pocket PEA with the locating ring on the leafclip ensuring a 
 good fit as shown in the diagram below.
 Slide the shutter blade of the leafclip back to reveal the sample.
 Press the measure button. It is important that the Pocket PEA and leafclip be held steady 
 while the measurement is being made to prevent any ambient light leakage.
 Once the measurement has been completed (either a 1, 3 or 10 second measurement 
 depending on the instrument configuration), the parameters Fv/Fm and PI are displayed 
 on the LCD. The measurement is then automatically saved and the instrument is 
 returned to a measurement ready status.
 Repeat this process for all dark adapted samples.
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Ensure all required data is downloaded and saved in the 
PEA Plus software before erasing data from the control 

unit. Once deleted, retrieval of records is impossible.

It is important to ensure that the shutter blade on the 
leafclip is opened. If the shutter is left in the closed 

position, the Pocket PEA will not perform a measurement.



The fluorescence signal received by the detector during recording is digitised using a fast, 
16 bit Analogue/Digital converter. Digitisation occurs at different rates depending upon the 
different phases of the induction kinetic. Initially, data is sampled at 10µs intervals for the 
first 300 µseconds. This provides excellent time resolution of Fo and the initial rise 
kinetics. The time resolution of digitisation is then switched to slower acquisition rates as 
the kinetics of the fluorescence signal slow. This process provides excellent time 
resolution of the overall measurement whilst minimising the size of the data set and thus 
ensuring optimum memory capacity. The table below shows the time resolution of 
sampling. 

e.g. A 1 second duration recording will comprise: 30 + 27 + 27 + 27 + 9 = 120 data points. 
A 10 second duration recording will comprise 145 data points.

The Pocket PEA is able to hold up to 200 measurements in the internal memory of the 
instrument. The number of measurements currently held in the memory is indicated by the 
number displayed in the bottom left corner of the instrument LCD display.

Measurements may be erased from the Pocket PEA either from the software or from the 
instrument. With the Pocket PEA switched off, press the On/Off key before immediately 
pressing and holding the Measure key. The LCD will prompt to press Measure to erase all 
recordings.
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Optical assembly 
mated with leafclip

Shutter blade in 
the open position

Number Of
Data Points Interval  Total Elapsed 

Time

30 10µs 300µs

27 100µs 3ms

27 1ms 30ms

27 10ms 300ms

27 100ms 3 secs

7 1 sec 10 secs



Charging the Pocket PEA.

As with all instrumentation with rechargeable batteries, it is good working practice to 
ensure that the battery is fully charged before first use. The Pocket PEA features the latest 
Lithium Polymer battery technology ensuring a full day of field usage and the convenience 
of rapid (<4hrs) recharge to full capacity using either the mains charger provided or an 
optional 12V DC vehicle charger. 

The charging indicator LED on the front of the instrument changes colour in order to 
indicate different states. The indications are as follows:

 When the charger is initially connected, the indicator LED is green.

 If the battery requires charging, the LED will change to orange.

 When charging is complete, the LED will turn green again.

If the LED flashes when the charger is connected, this indicates that there is a fault. In this 
instance, please contact Hansatech Instruments at the address at the rear of this 
document.

During use, the battery charge level is indicated in the bottom right corner of the LCD 
display.

40



Chapter 4
PEA Plus Software



Introduction to PEA Plus Software.
PEA Plus provides a comprehensive tool for in-depth analysis of data recorded by the 
Pocket PEA and Handy PEA chlorophyll fluorimeters. Several different data presentation 
techniques have been combined in order to effectively demonstrate subtle differences in 
the fluorescence signature of samples which could be indicative of stress factors affecting 
the photosynthetic efficiency of the plant. The following sections explain the different 
presentation methods employed by PEA Plus allowing the results from the Pocket PEA 
and Handy PEA to be interpreted accurately.

Installing PEA Plus Software.

The CD will run automatically when inserted into the CD ROM tray in a PC. From the 
Startup screen, select Install PEA Plus to launch the installation routine. Follow the on-
screen prompts to install PEA Plus on your PC. It is recommended to read through this 
manual thoroughly before using PEA Plus software in order to familiarise yourself with the 
different features and file transfer protocol.

Once PEA Plus is correctly installed on your PC, it can be launched from the PEA Plus 
icon on your desktop or from the link in the programs list which is accessed from the Start 
button on the Windows toolbar. Once the program has loaded, version and contact 
information may be accessed by selecting Help > About PEA Plus from the menu bar.

Transferring Data from the Pocket PEA.

In order to transfer recorded data from the Pocket PEA into the PEA Plus software, ensure 
that the instrument is successfully connected to the PC via a Bluetooth Wireless link. 
Information on establishing this link can be found in the Setting Up Bluetooth 
Communications section.

Run the PEA Plus software. From the menu bar (please 
refer to the Menu Bar section for further details) open the 
Pocket PEA > Select Bluetooth Port menu option.

Select the relevant COM port being used by the PC for the 
Bluetooth serial link. This can be found by viewing the 
properties of the Bluetooth serial link as described in the 
Setting Up Bluetooth Communications section. Press OK to 
accept the highlighted COM port.

The data transfer routine may be launched either from the Pocket PEA > Download all 
recordings menu bar option or by selecting the     icon from the toolbar (please refer to the 
Toolbar section for further information).

It is important to follow the Bluetooth module 
manufacturers installation instructions and ensure that the 
Bluetooth device is correctly configured before attempting 

any communications with the Pocket PEA.
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If the Bluetooth serial link has not been successfully established, a series of error 
messages will be generated. If the serial link between the PEA Plus software and the 
Pocket PEA has been correctly configured and data download my now take place. The 
following dialogue box will appear.

Press OK to download the data from the Pocket PEA. A new dialogue with status bar 
indicates the progress of the download.

Once the download is complete, the recorded data is initially presented as the default data 
set in the Summary screen as described in the following section. For further information on 
data sets, please see the Data Sets section.

Transferring Data from the Handy PEA.

A Word About Communications.

Data transfer from the Handy PEA to PEA Plus is performed via an RS232 serial 
connection between the Handy PEA and the PC. Unfortunately, due to advances in PC 
communications technology, RS232 is becoming more and more scarce on modern 
computers. It is now virtually impossible to purchase a new laptop PC with an RS232 port. 
If this is the case with the PC that you are using, it is possible to purchase USB - RS232 
adapters which connect to an available USB port which are present on all modern desktop 
and laptop PC’s.

Hansatech Instruments have tested a large number of USB - RS232 adapters from a 
number of different manufacturers. The HAN/USB adapter is the only adapter that can be 
used in complete confidence. Other adapters purchased elsewhere may have limited or no 
functionality with the Handy PEA and as such, will not be subject to technical support from 
Hansatech Instruments Ltd.

If you have purchased a HAN/USB RS232 - USB adapter, please read the installation 
instructions supplied with the item before attempting to install. The following sections on 
transferring data and any section associated with communications between the Handy 
PEA and PC assume that the HAN/USB has successfully been installed.
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Establishing an RS232 Connection.

In order to download saved files to PEA Plus, it is important to ensure that the Handy PEA 
control unit is correctly linked to the PC via the supplied RS232 cable. Also, the Handy 
PEA control unit must be set to PC MODE which is configured from the Handy PEA Main 
Menu screen (for further details, please consult the PC Mode Operation section in the 
Handy PEA chapter of this manual). Make a note of the serial COM port number to which 
the instrument is connected as the PEA Plus software will require this information. Open 
PEA Plus and select the Select COM Port from the Handy PEA drop down menu.

Select the relevant radio button within the Serial 
Port dialogue according to the COM port 
number to which the Handy PEA control unit is 
connected. Press OK to accept and configure 
the software to communicate through the new 
COM port.

To initiate the download function, select either the    button from the Toolbar or the 
Download Recordings option from the Handy PEA drop down menu.

If the RS232 connection is active, the Download 
Recording from Handy PEA dialogue will be 
displayed by PEA Plus as shown in the image 
opposite. Should no RS232 connection be 
detected by PEA Plus, a warning message will be 
generated prompting to check the connection and 
the PC Mode status of the Handy PEA control unit. 
By default, the Download Recordings from Handy 
PEA dialogue will display the first and last file 
numbers detected in the Handy PEA internal 
memory. Select the files required for download by entering the relevant first and last file 
numbers in the dialogue spin boxes. Pressing OK will proceed with the download. A new 
dialogue with status bar tracks the progress of the download as shown in the image below.

Once the download is completed, the results are presented directly in the Summary screen 
analysis function of the PEA Plus program. This feature is described in the following 
section.
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Data Presentation Tools within PEA Plus.
PEA Plus software allows data to be presented using several different data analysis 
techniques. Each method of analysis occupies an individual screen which may be selected 
by clicking on the relevant tab which appears at the top of the data display area. The 
following sections describe each individual data presentation screen and instructions on 
how best to interpret the information displayed.

The Summary Screen.

The summary screen is the first screen that is displayed when data is either downloaded 
from the fluorimeter or opened from a previously saved file. It serves as a summarising list 
of all the measurements and allows individual, groups and sets or all of the recordings to 
be selected for further analysis using one of the other data presentation methods in PEA 
Plus. The diagram below and following points provide detailed information on the individual 
components and functions of the PEA Plus summary screen.
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 A and B: Menu and Tool bars.
These are fundamental features of the PEA Plus software and not specific to the summary 
screen. Please refer to the relevant Menu Bar and Toolbar sections for further details.
 
 C: Data Analysis Method Selection Tabs.
These are also fundamental features of the software and will always appear at the top of 
the PEA Plus Window. Once recordings have been selected from the summary screen, 
clicking on each of these tabs will display the selected recordings using the corresponding 
analysis method.

 D and E: File Information Panel. 
The File Information Panel serves to indicate the number of individual recordings present 
in the current file and also the number of those files that have been selected for analysis.

When data is downloaded from the fluorimeter or a previously saved file is opened, all 
recordings are selected for analysis by default. Individual or multiple files may be selected 
for analysis or grouping in up to 8 additional data sets (please refer to the Data Sets 
section for further information). The selection of records may be performed in various 
different ways:

  • Double-clicking the mouse on a recording will change the state of the line from  
  selected to unselected or vice-versa.
  • From the Select Records Panel, click the                               button to unselect all 
  recordings in the Summary screen. Single click the mouse on records to highlight 
  the required data. Groups of consecutive recordings may be selected by 
  highlighting the first file in the group with a mouse click, holding down the SHIFT  
  key followed by clicking the last required record in the group. Groups of non- 
  consecutive recordings are selected by highlighting individual required records  
  whilst holding down the CTRL key.

  Highlighted recordings are then selected for analysis by either right-clicking the  
  mouse and choosing Select Highlighted Records from the context sensitive menu or 
  by selecting the same option from the Edit Menu on the Menu bar.

All recordings may be easily re-selected by clicking the                               button from the 
Select Records Panel.

Selected traces (M in the Summary screen diagram) may be identified in the summary 
screen by the presence of a      symbol and a corresponding colour block in the Trace 
column of the Summary screen. Unselected traces (L in the Summary screen diagram) do 
not have these features and are greyed out as an additional identification aid.
 
 F: File Comment Allocation.
Clicking this button provides the user with the ability to allocate a text comment to the 
saved file. General information regarding the recordings may be useful in some cases 
when is is not possible to sensibly describe the file from the saved filename alone. The 
textbox allows 3 lines of text to be defined as shown in the diagram below.
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 G and H: Select Records Panel Controls.
The All and None controls in this panel are concerned with record selection for data 
analysis as described previously in the File Information Panel section. The
button allows records to be selected according to any ID reference that has been assigned 
to a record. An ID may be assigned to Handy PEA records at the measurement stage 
(please refer to the ID Entry section of the Handy PEA chapter) or from within the PEA 
Plus software itself (please see the Edit Menu section). Pocket PEA records may only 
have ID references assigned from within the PEA Plus program.

 I: Allocated Trace Colours.
When data is downloaded from the fluorimeter, PEA Plus software is configured by default 
to automatically assign colours to each individual record to be used in the Graph and 
Spider Plot data analysis screens for identification purposes. 20 different colours are used 
and assigned to the first 20 individual consecutive records. If more than 20 records are 
present, the colour scheme repeats itself for the next records in the file. The colour that is 
assigned to the record is displayed in the Trace column of the Summary screen. The 
automatic allocation of trace colour and the specific colours used are user definable and 
may be accessed from the Tools > Display Options menu bar option (please refer to the 
Display Options section for further details on this dialogue box). 

At the top of the Display Options dialogue window are the settings for the Graph and 
Spider Plot Colours. Unchecking the Automatic on Download option configures PEA Plus 
to assign black as the corresponding trace colour for all records when data is downloaded 
from the fluorimeter. Selecting the Edit Auto Colours button allows the 20 colours to be 
customised from the dialogue shown in the diagram below.

Trace colours may be cleared using the Tools > Clear Colours menu bar option or re-
selected using the Tools > Auto Colours menu bar option.

47



 J: Fo Parameter Panel.
Before the development of instruments such as Pocket PEA and Handy PEA, chlorophyll 
fluorimeters were limited by electronics as to how fast the Kautsky fluorescence induction 
could be measured. Since the development of modern fluorimeters, we now know that the 
value that was historically used as the Fo value, is in fact the parameter that we now term 
as F1 at 50 microseconds. Since the Pocket PEA and Handy PEA have maximum data 
acquisition rates of 10 microsecond intervals, we are able to extrapolate back to the time 0 
point using least squares regression of the first few data points. This allows PEA Plus to 
present an accurate approximation of the Fo parameter.

Select either the Calculated Fo or Use F1 radio buttons to configure the Fo parameter. 
Please see the Fo Parameter section for further details on how the extrapolation is 
performed.

 K: User Values Columns.
User Values columns allow up to 3 additional columns of non-fluorimeter data to be 
inserted into the PEA Plus Summary Screen. This data is available in all analysis screens 
for direct comparison with either Handy PEA or Pocket PEA fluorescence data with the 
exception of the Graph and Tabulated Data Screens. 

User Values data could be from other types of instrument with numerical values collected 
from the sample i.e. chlorophyll content values from the Hansatech Instruments CL-01 
(please contact Hansatech Instruments Ltd at the address on the rear of this document for 
further information), gas exchange data or spectral reflectance information. User Values 
may be entered in 2 different ways:

• Manual entry of User Values.
From the User Values check boxes on the left side of the Summary Screen, select the 
required number of columns to be displayed in PEA Plus. Highlight the required record to 
which the User Value is to be assigned. From the Edit drop down menu, select Edit User 
Data to display the dialogue box shown below.

Type the relevant data into the required column. This procedure should be followed for 
each row that requires a User Value entry.
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The actual Fo parameter occurs at time 0 which unfortunately, due to electronics 
capabilities is impossible to measure. It may be difficult to justify to Reviewers using 
a calculated Fo when submitting data for publication. The F1 parameter is used as a 
preference for paper submission as it is less problematic in justifying Fo as a value 

taken at a fixed time base of 50 microseconds.

We are, however, confident that the calculated Fo is a more accurate value.



• Copy and Paste from Microsoft Excel®.
Entire columns of numeric values can be copied 
from Microsoft Excel Spreadsheets® and pasted into 
the PEA Plus User Values columns. Within Excel®, 
highlight the column or required values and copy 
them to the Windows Clipboard®. Return to PEA    
Plus Summary Screen and activate the required 
User Values column using the checkboxes on the 
left side of the screen.

Highlight the first row in which the User Values are 
to be pasted and right click the mouse to open the 
context menu. Selecting Paste User Data opens the 
opposite dialogue box. This dialogue indicates the 
number of rows of User Data to be pasted into the 
User Values column. Select the required column and 
starting row and click OK to paste the data.

Data entered into the User Values columns is saved along with the fluorescence data. 
User Values data may be removed from the file by selecting the required column to delete 
from the Edit > Clear User Data drop down menu option.

 N: Hot Parameters.
In the Summary screen, recordings are displayed on individual lines showing date and 
time of the recording. Also displayed are 2 user definable “Hot Parameter” columns. Hot 
parameter columns serve to provide an immediate visualisation of 2 user definable 
parameters which may be considered highly significant to the experiment. The default Hot 
Parameters are Fv/Fm and PI (Performance Index*). 

These 2 parameters are considered 
by many as being the most 
diagnostically significant parameters 
for the indication of stress in plants. In 
order to select alternative Hot 
parameters, select Tools > Hot 
Parameters from the menu bar to 
display the dialogue opposite. 

Select 2 required Hot parameters 
from the list by checking / un-
checking the corresponding radio 
buttons. 

Clicking OK to accept will display the 
relevant data in 2 columns on the 
right side of the summary screen.

Once all, individual or groups of records have been selected within the summary screen, 
clicking on the different tabs along the top of the data display area plots the relevant data 
using one of the PEA Plus data analysis techniques.
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Data Sets.

From the Summary screen, PEA Plus offers the ability to group records into individual data 
sets. This allows convenient separation of groups of records within the main file set. For 
example, in a set of 40 records, 10 measurements are from a control sample with a further 
10 measurements from each of three different experimental conditions. It is possible to 
group each set of 10 recordings into an individual data set for separate analysis and for 
direct comparison with the other data sets.

The records are sorted into sets from the Summary screen using a series of Toolbar 
buttons.

From the Summary screen, select only the records required for a new set as shown in the 
diagram below.

Once the required records are all correctly selected, click the       button on the toolbar. 
This button confirms the selection and highlights the selected records in red as shown in 
the following image. 
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Once the selected records are highlighted in red, the Set number buttons on the toolbar all 
become active. To commit the selected records to a data set, select one of the 8 set 
number buttons on the Toolbar. The data will be assigned to whichever set number button 
is clicked. Once a set number is selected, the following dialogue is opened.
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The Save Set dialogue allows final adjustments to be made to the set before it is saved. A 
title for the set such as Control or Treatment Group 1, etc., may be added. Also, records 
may be added or removed from the set by clicking on the appropriate record number in the 
Set Contains or Set does NOT Contain windows and selecting the Add or Remove buttons 
respectively. 

The Spider Reference option allows a particular record within the set to be used as a 
control for the Spider Plot analysis tool. All other records in the set will then be plotted on 
the Spider relative to the reference.

Once the set is saved, the corresponding Set Number button on the Toolbar becomes 
active allowing the set to be selected for further data analysis within the other screens.

Managing Sets.

Sets may be edited at any point by selecting the       button on the toolbar to open the 
Manage Sets dialogue box. This dialogue is essentially the same as the Save Set dialogue 
with the exception of 2 main points. In the Manage Sets dialogue, it is possible to select 
any of the defined sets from the Set number buttons at the top of the dialogue. Clicking 
any of the buttons displays the respective set properties and allows them to be edited 
accordingly. A Delete button is also active in the Manage Sets dialogue allowing entire 
sets to be deleted. Once a set is deleted, the set number button on the Toolbar becomes 
inactive.

Another method of editing the set is to perform changes directly in the Summary screen. 
Select the required set from the set number Toolbar buttons (further information on these 
control buttons may be found in the Toolbar section of this document). The set number 
and given title will be displayed at the top of the summary table in bold type. Selecting 
further records or unselecting records will cause the set number and title at the top of the 
table to fade out indicating that changes have been made to the active set. Attempting to 
access other sets from this point will generate a warning message indicating that the set 
has been edited and offers the option to save the changes.

Once all the data sets have been defined as required, the data held within the set may be 
analysed individually or (in the case of graphical data analysis tools), displayed onscreen 
in a tiled format for visual comparison between data sets. Further details of how to display 
the data sets within the PEA Plus data presentation tools is given in the following chapters.

An example data file is included with this software and is installed to the following location 
during the installation of PEA Plus software:

c:\Program Files\Hansatech Instruments Ltd\PEA Plus\Data\Example Data File.pcs

This file consists of 40 records taken from 4 samples in various stages of senescence from 
the control through to an almost dead leaf. 10 x one second records were taken from each 
sample and transferred to the PEA Plus software were the averages of each sample were 
added to the foot of the Summary table. The records for each sample and the averages 
have been divided up into data sets.

This data file has been included with the installation in order to highlight the benefits of 
using of sets within a group of records. If the sample data file is lost or the original version 
is required, it may be downloaded from the Software Upgrades section of our website.
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The Graph Screen.

The graph screen plots all the individual data points from each selected recording showing 
fluorescence over time. As mentioned previously in the Kautsky Fluorescence Induction 
section, the major inflection points of the fluorescence rise occur within the first 300 
microseconds of measurement making it difficult to plot on an axis with a linear time base. 
The fluorescence recordings are therefore plotted on a logarithmic time axis allowing the 
polyphasic rise to maximum fluorescence value clearly visible. 

Any recordings that are selected in the active data set in the Summary screen are 
automatically plotted on the graph screen when the Graph tab is selected from the tabs 
above the data display area. Graphs may be presented in either single or multi-pane views 
allowing direct visual comparison between user-defined data sets (please refer to the Data 
Sets section for details on defining data sets). 

The diagram below and following points provide detailed information on the individual 
components and functions of the PEA Plus graph screen.
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 A: Cursor Position Information.
Hovering the mouse cursor above any point on a trace plotted in 
the data display area will perform 2 functions. Firstly, a data 
information popup box (shown in the diagram opposite) will be 
generated giving full details of the data point closest to the 
hovering cursor. Secondly, the time and fluorescence value of the 
same data point will be displayed in the cursor position information 
area.

 B: Trace Settings Information.
The trace settings information area allows certain elements of the plotted traces to be 
configured. The following characteristics are definable:
 • Point Size. This setting refers to the marker that is used to denote an individual data 
 point. A square in the corresponding trace colour is used to mark each data point. 
 Alternate point sizes are selected by adjusting the spin box adjacent to the Point Size 
 text. The default setting is 5 however, when many traces are plotted, it may be 
 preferable to alter the point size to 0 in order to prevent the graph from appearing 
 “overcrowded”.
 • Grid lines may be hidden by un-checking the Grid Lines check box.
 • Traces may be hidden from view by un-checking the Trace Line check box.
 • The Timemark lines are shown on the graph screen as blue vertical lines. These 
 marks correspond to the T1, T2, T3, T4 and T5 in the Parameter Display screen  
 (please see Parameter Display Screen for further information). They are concerned 
 with the calculation of the PI (Performance Index) by taking the fluorescence value at 
 definite times through the measurement. The time bases for the marks are as follows:
  T1 - 50 µsecs
  T2 - 100 µsecs
  T3 - 300 µsecs
  T4 - 2 msecs
  T5 - 30 msecs
 
 Un-checking the timemarks check box will hide the vertical timemark lines.
 • Un-checking the Popup Boxes check box will de-activate the data point information 
 popup boxes (see Cursor Position Information section above).

 C: Fluorescence Axis Controls.
The fluorescence axis control allows the vertical axis to be scaled in the most appropriate 
way in order to best display the plotted data. Upper and lower axis limits may be manually 
configured by typing the required fluorescence levels into the min. and max. boxes and 
pressing the Redraw button. The axis is then adjusted to display the plotted fluorescence 
traces according to the new settings. Alternatively, pressing the Auto button allows PEA 
Plus to automatically optimise the fluorescence axis settings in order to provide the best 
resolution for data display.

 D: Time Axis Controls.
The graph screen is viewed by default using a logarithmic axis. In this viewing mode, the 
time axis automatically scales to the trace of longest duration. Un-checking the Log check 
box displays the graph on a linear time axis. The time axis controls are only relevant when 
viewing the graph on a linear time axis. They operate by entering minimum and maximum 
time in either µsec, msec or seconds depending on which option is selected from the Units 
drop down box. As with the fluorescence axis controls, pressing the Redraw button re-
plots the graph on the selected time base. Alternatively, click the Auto button to 
automatically scale the graph with the most appropriate time base.
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Multi-Pane Display of Graphs.
The Graph screen may be configured to display selected records within data sets in either 
a single or multi-pane view. These views are controlled by the Graphical Display Control 
buttons on the toolbar (please refer to the Toolbar section for further details on these 
controls). 

When in single pane view mode, any of the defined data sets can be graphed by clicking 
on the corresponding set number button on the toolbar or by using the left and right arrow 
buttons on the toolbar to scroll through the different defined data sets. PEA Plus also 
provides a slide show feature which allows the data set graphs to be scrolled 
automatically. Please refer to the Toolbar section of this document for full details on the 
use of the Graphical Display Control buttons. 

It is important to note that only selected files within the data sets will be plotted on the 
axes. It is necessary to return to the Summary screen in order to select the records within 
the data set that are required to be plotted. 

Multi-pane view mode allows multiple data set graphs to be plotted on screen allowing 
convenient visual comparison of the data sets. Graphs can either be displayed 4 at a time 
or all together on a single screen which again is controlled by the Graphical Display 
Control buttons on the toolbar. The image below shows 4 data sets plotted for visual 
comparison. The corresponding data set number is printed at the top left corner of each 
individual data set graph for identification purposes. In the multi-pane viewing mode, any 
alterations made to the axes and trace settings are universal meaning all graphs in the 
current view will be affected.
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The Rank Plot Screen.

The Rank Plot displays a hierarchy of values for individual parameters for records/data 
sets currently selected in the Summary screen. Values may be plotted either in ascending 
or record number order from left to right across the data display area. 

A parameter list at the left side of the screen allows individual parameter selections to be 
made. This tool serves to highlight major differences in the spread of results for each 
parameter measured by the fluorimeter. In addition, a Distribution Plot at the bottom of the 
Rank Plot screen displays the frequency with which similar values occur. As with the 
Graph screen, since the Rank Plot is a graphical analysis tool, multi-pane views are 
possible using the display controls on the toolbar (further information on the Graphical 
Display Control buttons can be found in the Toolbar section).

The following diagram and points provide detailed explanations of the features and 
components of the Rank Plot screen.
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 A: Parameter Selection.
Selecting any of the parameters from the Parameter Selection area plots the 
corresponding parameter values for all selected data currently in the Summary screen 
view. 

 B: Rank Plot Settings.
There are 2 settings available for the Rank Plot screen. The Rank 
Numbers check box is de-activated as default. Checking this box 
displays the relevant record number below the plotted points in order 
to facilitate immediate recognition of records.

The other configuration setting is for Popup Information Boxes. In the 
Rank Plot data area, hovering the mouse cursor near to a plotted 
point will display an information popup as shown in the opposite 
diagram. This popup box shows the file and record numbers of the 
plotted point along with the date and time of the record and finally the 
value of the parameter that has been selected to plot.

Popup Information Boxes are also displayed in the Parameter Distribution Plot as shown in 
the image below. Hovering the mouse cursor over the top section of the graph bars 
displays the popup. The top section on the box is common information regarding the 
Distribution Plot for the selected parameter.

 No. Of Bars - The number of bars available.
 ‘Width’ of Bars - This value is calculated from the difference between the minimum and 
 maximum sample values divided by the number of bars on the plot. 
 Minimum Sample - The lowest parameter value in the selected records.
 Maximum Sample - The highest parameter value in the selected records.
 Maximum Frequency - The highest number of records in one frequency range.

The lower section of the popup indicates information for the bar closest to the cursor. In 
the above diagram, this bar has a range in value of the Fv/Fm parameter of 0.47 to 0.81 (a 
bar width of 0.0085 as indicated in the upper section of the popup). The Frequency is the 
number of records which have an Fv/Fm value (or whichever parameter is selected to plot) 
which falls within the bar range. When the Parameter Distribution popup bow is displayed, 
the data points which fall into the viewed range are highlighted in the Rank plot area 
above.

 C: Rank Plot Data Display Area.
By default, parameter values in the Rank plot are displayed in record number order from 
left to right across the screen. However, by checking the Rank Plot Data Sorted option in 
the Display Options dialogue (accessed from the Tools menu option. Please refer to the 
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The colours for Rank Plot data points may be altered by using the Display Options 
dialogue box which may be accessed from the Tools drop down menu (please refer to the 
Display Options section for full details of this dialogue box). The data points may be 
coloured automatically using a user-defined number of colours, coloured according to   
Fv/Fm or PI  Thresholds of Concern (please refer to the Thresholds of Concern section for 
further information on the meaning of these colours), or coloured black.

 D: Parameter Distribution Plot.
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The Parameter Distribution Plot indicates the number of individual records with a 
parameter value which falls into set band ranges. In the previous diagram, 14 records 
have been selected from the Summary screen. The difference between minimum and 
maximum Fo value for the record set is 2480. This value is divided by the number of 
records selected to give the number and width of the available bands. The bars are then 
plotted according to the number of records with parameter results which fit into each of the 
bands.

The Parameter Distribution Plot allows a clear visualisation of variations in parameter 
values throughout the selected data set.

Multi-Pane Display of Rank Plots.

Rank plots for multiple data sets may be viewed simultaneously on screen using the 
Graphical Display control buttons on the Toolbar (please refer to the Toolbar section for 
full details of the functionality of these control buttons). The image below shows Rank plots 
for 4 individual data sets displayed in multi-pane viewing mode. It is important to note that 
only selected files within the data sets will be plotted. It is necessary to return to the 
Summary screen in order to select the records within defined data sets that are required to 
be plotted. 

Both the Rank and Parameter Distribution plots are displayed for all currently selected 
records within defined data sets. Please note that whilst in multi-pane viewing mode, 
parameter selections will affect Rank plots for all data sets in view.
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The Parameters Screen.

The Parameters Screen shows all or a user-defined set of the available parameters which 
have been calculated from the raw fluorescence signal measured by the fluorimeter. 
Parameters are displayed for all records currently selected in the Summary Screen and 
are presented in a spreadsheet type format as shown in the image below. Individual 
parameters may be hidden from the screen by unchecking the relevant checkbox at the 
left side of the Parameter Screen. Available parameters are grouped into 3 individual 
categories. General, Time Marks and Performance Index related parameters. The 
methods by which each of the parameters are calculated are described in the Parameters 
Measured section of the Introduction to Chlorophyll Fluorescence chapter.

Parameter columns are placed from left to right across the viewable screen area. Further 
parameters which are off the screen area may be scrolled into view using the horizontal 
scroll bar at the base of the screen.

These parameters may be exported to external data analysis applications such as 
Microsoft Excel® using the Export Parameters function in the Files drop down menu. 
Please refer to the Files Menu section for more information.
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Thresholds of Concern.

Thresholds of Concern may be applied to the Fv/Fm and PI parameter display columns in 
the Parameter Screen and optionally in the Summery Screen (depending on which Hot 
Parameters are selected. Please refer to the Summary Screen section for further details). 
Thresholds of Concern and the associated coloured markers provide rapid identification of 
records which have low values for Fv/Fm and/or PI. 

2 values may be defined for each parameter in order to indicate 3 possible states. These 
values should be relevant to the current project where it has been pre-determined that 
samples with values lower than the defined levels require specific levels of attention. 

Thresholds of Concern levels may be set from the Tools > Display Options menu bar 
option as shown in the image above (please refer to the Display Options section for further 
details on this dialogue box).

When records are downloaded to the PEA Plus software, the Fv/Fm and PI parameter 
columns display lists of values for individual records accompanied by a coloured 
marker. These coloured markers may be one of three possible colours used to indicate 
when a value falls into one of the Thresholds of Concern. 

 Green:
Indicates that the Fv/Fm or PI value is above the level defined for Threshold of Concern 1. 

 Amber:
Indicates that the Fv/Fm or PI value has fallen below the level defined for Threshold of 
Concern 1 but is still above the Threshold of Concern level 2. Further analysis of these 
records is required. 
 
 Red:
Indicates that the Fv/Fm value has fallen below the level defined for Threshold of Concern 
2. Immediate attention should be given to these samples.
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The Settings Screen.

This screen is designed to indicate instrument settings and any software scaling factors 
that have been applied for each of the records. The instruments settings columns are:

 Dur. (sec) - Measurement duration for an individual record.
 Light - Light intensity used for each individual record in µmols m-2 s-1.
 
This feature is useful as a diagnostic tool. For example, unexpected low Fv/Fm values may 
be as a result of insufficient saturating light intensity. An incorrectly set light intensity may 
be easily visible by checking the settings screen.

Date, time and record number and ID (if assigned) of individual records are also displayed 
along with the corresponding assigned trace colour. Individual settings columns may be 
hidden from the view by unchecking the relevant item in the Preferences panel on the left 
side of the screen. Certain settings shown are related to Handy PEA records only and are 
not relevant to Pocket PEA records. Options which are unrelated will be greyed out when 
Pocket PEA records are displayed.

The Tabulated Data Screen.

The Tabulated Data Screen displays a table of the raw fluorescence signal recorded by 
the fluorimeter with the individual record number on the top row and the data point number 
and time base of each data point in the left columns of the table.

The Time Mark data points are set by default to be highlighted. However, this feature may 
be disabled by unchecking the Time Marks option in the Preferences panel.

When exported into other data analysis applications such as Microsoft Excel®, it is this 
data that should be used in order to re-constitute the fluorescence curves or for calculation 
of additional parameters and indexes not available in the PEA Plus software. For further 
details on data analysis in external applications, please refer to the Export Data Points 
section.

The Spider Plot Screen.

Spider or Radar plots provide a convenient method of comparing 2 factors:
 
 The spread of individual parameter values for selected records within a data set.
 A visualisation of which parameters have greater variance which may therefore offer 
 greater sensitivity when monitoring sample response to certain types of stress.

The Spider plot screen consists of a parameter selection bar and data display area. The 
parameter selection bar allows configuration of the plot in order to display the most 
appropriate parameter set for the application. At the top of the parameter selection bar is 
the Reference drop down menu. This control contains the record numbers of any records 
currently selected in the Summary screen. All selected records are plotted on the Spider 
plot axis relative to the Reference record.

When multiple data sets are defined, Reference record numbers must be assigned for 
each data set. This may be configured from the Manage Sets (     ) button on the Toolbar 
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(please refer to the Toolbars section for further information) or by selecting the relevant set 
number button from the Toolbar and selecting the required Reference record number 
directly in the parameter selection bar on the Spider plot screen. The image below shows 
an example of a Spider plot using the Averages data set in the Example Data File.pcs 
included with the PEA Plus software installation. 

This plot highlights the variation within the results for each parameter. It also serves to 
indicate which parameters may offer greater sensitivity. For example, from the plot above, 
we can clearly see 4 distinct Fv/Fm values. The variation between the Fv/Fm results is 
however, not as great as the variation in PI parameter values. 

The Spider plot may be scaled in order to fit the display area by clicking on the intersecting 
point between the Reference line and the Spider axes and dragging the plot to the 
appropriate size. This control is indicated at the top left corner of the data display area.
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Multi-Pane Display of Spider Plots.

Spider plots for multiple data sets may be viewed simultaneously on screen using the 
Graphical Display control buttons on the Toolbar (please refer to the Toolbar section for 
full details of the functionality of these control buttons). The image below shows Spider 
plots for 4 individual data sets displayed in multi-pane viewing mode. The Reference 
record number for each data set is displayed adjacent to the corresponding Spider axes.

It is important to note that only selected files within the data sets will be plotted. It is 
necessary to return to the Summary screen in order to select the records within defined 
data sets that are required to be plotted. Please note that whilst in multi-pane viewing 
mode, parameter selections will affect Spider plots for all data sets in view.
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PEA Plus Menu & Toolbar.
As with most standard Windows applications, software functions are grouped together in 
the form of drop down menus with access to the more commonly used functions also 
available from buttons on the Toolbar. The following sections describe the different 
features that may be accessed from the Menu and Toolbar.

The Menu Bar.

 Files Menu.
The PEA Plus Files menu option offers access to standard Windows® menu options such 
as New, Open, Close, Save, Save As, Print control functions and a program exit option. A 
recent file list containing the 4 previously viewed data files is featured in the bottom section 
of the Files menu. This document assumes that the user is familiar with these standard 
features and has therefore not included relevant descriptions. Should any assistance be 
required for these features, please refer to the Windows® Help and Support documents. In 
addition to the standard features, PEA Plus offers the following menu options:

 • Export Parameters. - This functions exports the calculated parameters from all  
   records regardless of selected records or defined data sets. Parameter sets are saved 
   as *.CSV (Comma Separated Values) format files and may be opened directly in   
   external data analysis applications such as Microsoft Excel®. A sample exported  
   parameters file is included with the installation of the PEA Plus installation and may be 
   found in the following location on your PC:

  c:\Program Files\Hansatech Instruments Ltd\PEA Plus\Data\Example Data File.csv

 • Export Data Points. - As above but *.CSV file contains all individual data points  
   recorded by the fluorimeter during the measurement. This allows traces to be re- 
   constituted in external data analysis applications for further study.
 • Export to HAN. - HAN refers to the file format used for files recorded by the Handy 
   PEA and saved in previous versions of the Handy PEA software. This function allows 
   records to be exported to a file format which is recognised by previous versions of  
   Handy PEA software and is essentially a backwards compatibility feature for new  
   Handy PEA data files. However, by converting the new records to HAN format, it is  
   possible to open the files in the *Biolyzer external analysis application.

 Edit Menu.
The options within the Edit menu are exclusively relevant to the Summary screen only. In 
any of the other analysis screens, the Edit menu options are greyed out and inaccessible. 

 • Select Highlighted Records. - Selects any currently unselected records that have  
   been highlighted in blue with a single mouse click.
 • Unselect Highlighted Records. -  Unselects any currently selected records that have 
   been highlighted in blue with a single mouse click.
 • Select All Records. - Automatically selects all records in the current Summary  
   screen view regardless of current status.
 • Unselect All Records. -  Automatically unselects all records in the current Summary 
   screen view regardless of current status.
 • Select by ID. - Used to automatically select records with matching ID’s.
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 • Edit Colour of Trace(s). - Allows currently assigned trace colours for individually  
   highlighted records to be amended. 
 • Edit ID. - Allows an ID reference to be entered to a highlighted record. This function is 
   particularly useful to differentiate between groups of common recordings within a  
   larger group of records. A string of up to 6 alphanumeric characters may be used.
 • Edit User Data. - Allows non-fluorescence values to be manually entered into the  
   User Values columns. Please refer to the User Values Columns section for further  
   information.
 • Clear User Data. - Deletes entered data from the User Values columns.
 • Cut, Copy & Paste. - These are similar to the standard Windows® commands of the 
   same names. However, these functions only allow records to be moved between files 
   within the PEA Plus program i.e. Records may not be copied to applications other  
   than PEA Plus. Individual or groups of highlighted records are copied to an internal  
  scratch pad and not to the Windows® Clipboard. Cut or Copied records are offered  
  the option to be pasted before or after a user-defined record number.
 • Comment. - Has the same functionality as the Comment button on the left side of the 
   Summary screen. Please see the File Comment Allocation section for further details.
 • Average. - If one 2 or more records are highlighted, selecting this option will generate 
   a new record with the average values of all the parameters calculated from the  
   highlighted records. Once the average record has been generated, PEA Plus will  
   open a dialogue allowing the entry of a reference ID for the record of up to 6                
   alphanumeric characters. A further dialogue allows the location of the new record  
   within the Summary screen to be configured. Users may choose to place the average 
   record at the start or end of the records list or to select a specific line number where 
   the records is to be placed. Once the average record has been successfully inserted 
   into the Summary screen view, it behaves exactly the same way as a standard record.
 • Scale. - Generates a dialogue with the option to manually apply scale and offset to a 
  highlighted record. The scale feature may be used in situations such as where Handy 
  PEA records which have been measured with different gain settings are required to be 
  compared. For example to compare a record measured at x1 gain with a record  
  measured at x2 gain, a scale factor of 0.5 should be applied to the record with the  
  higher gain setting.

  The offset feature may be used to subtract a portion of each data point in a 
  highlighted record. For example, if a record with an Fo value of 500 is to be compared 
  with an Fo level of 250, an offset of 250 may be applied to the record with the higher 
  Fo value. This will give the 2 records identical Fo values allowing other factors of the 2 
  records to be compared.

  Any records which have been assigned scale or offset values are highlighted in pink in 
  the Summary, Parameters, Settings and Tabulated Data screens.
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  • Normalise. - The normalise function allows scale and offset to be automatically  
  applied to 2 or more highlighted files. When the Normalise function is selected, PEA 
  Plus generates a dialogue box as shown in the image below.

  This dialogue box offers the ability to select a particular parameter value from a user-
  defined record number in the Summary screen. From the image above, the Fo  
  parameter value in any highlighted records will be normalised to the Fo value from  
  record number 1.
 • Un-scale/Un-Normalise. - Selecting this option removes any scaling/normalisation 
  factors from any highlighted records.

 Handy PEA Menu.
 • Select COM Port. - Allows configuration of the serial port through which RS232  
  communications between the PC and Handy PEA control unit will occur. Please refer 
  to the Transferring Data from the Handy PEA section for further details on this  
  function.
 • Download Recordings. - Opens the Download Recordings from Handy PEA  
  dialogue box if a successful RS232 connection has been detected. Please refer to the 
  Transferring Data from the Handy PEA section for further details on this function.
 • Get Status. - This option requires the Handy PEA to be set to PC Mode and  
  connected to the PC via the RS232 serial connection. If a successful connection is  
  detected, the Handy PEA Status dialogue box is displayed. This information window 
  contains basic instrument details including last record number used, instrument time 
  and date settings and the firmware version number along with the names and status 
  of any protocols held in the Handy PEA memory. Protocols may be deleted from the 
  Handy PEA memory from this window by pressing the Delete button beside the  
  unwanted protocol status line.
 • Synchronise Date & Time. - This option requires the Handy PEA to be set to PC  
  Mode and connected to the PC via the RS232 serial connection. It allows the Handy 
  PEA internal date and time settings to be synchronised with the date and time settings 
  of the PC.
 • Protocol Editor. - Opens the PEA Plus Protocol Editor. Please refer to the Protocol 
  Editor section for full details on this function.

 Pocket PEA Menu.
The Pocket PEA is intended as an easy to use, rapid screening tool. Configuration options 
for the Pocket PEA are software based only with the exception of a Delete All Records 
function. The following section details configuration options relevant to the setting up of the 
Pocket PEA for measurement.
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 • Select Bluetooth Port. - Allows the configuration of the Bluetooth port through which 
  Bluetooth wireless communications between the PC and Pocket PEA will occur.  
  Please refer to the Transferring Data from the Pocket PEA section for further details 
  on this function.

 • Setup. - Selecting this option requires an active Bluetooth connection between the  
  Pocket PEA and the PC. For further details on creating a Bluetooth wireless 
  connection, please refer to the Setting Up Bluetooth Communications section in the 
  Pocket PEA chapter of this document. This option opens the Setup Pocket PEA  
  dialogue providing access to the configuration settings for the Pocket PEA 
  measurement. 1, 3 or 10 second measurement duration may be selected by clicking 
  the relevant radio button and  measurement light intensity between 1 and 3500  
  µmols m-2 s-1 may be selected by dragging the slider bar to display the required  
  value as shown in the image below.

 • Download All Recordings. - Selecting this option requires an active Bluetooth  
  connection between the Pocket PEA and the PC. For further details on creating a  
  Bluetooth wireless connection, please refer to the Setting Up Bluetooth 
  Communications section in the Pocket PEA chapter of this document. For full details 
  on the Pocket PEA file transfer procedure, please refer to the Transferring Data from 
  the Pocket PEA section.
 • Erase All Recordings. - Selecting this option requires an active Bluetooth   
  connection between the Pocket PEA and the PC. For further details on creating a  
  Bluetooth wireless connection, please refer to the Setting Up Bluetooth 
  Communications section in the Pocket PEA chapter of this document. This option is 
  used to delete all records currently held in the Pocket PEA internal memory.
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 Tools Menu.
 • Display Options. - The different features within this dialogue box are described from 
  the image below:

  A: Graph and Spider Plot Colour controls. The features in this section of the Display 
  Options dialogue allow colours for traces in the Graph and Spider Plot screen to be  
  configured. By default, the Automatic on Download checkbox is checked. This allows 
  PEA Plus to automatically assign a series of 20 colours to records that are 
  downloaded into the software. Clicking the Edit Auto Colours button allows a scheme 
  of 20 colours to be user-defined. These colours will be assigned automatically to the 
  first 20 records in the summary screen. If more than 20 records exist, the colour  
  scheme will repeat itself.
  B: Thresholds of Concern. This area of the Display Options dialogue allows Threshold 
  of Concern parameter value levels to be user-defined. Please refer to the Thresholds 
  of Concern section for full details on the use of this feature.
  C: Rank Plot Colours. This feature allows the colours for the parameter value points 
  plotted in the Rank plot to be user defined. Four different settings are available for  
  selection from the Display Options dialogue.
   • Automatic. - This option uses an automatic colour scheme consisting of up to 10 
   colours. Parameter value points on the Rank Plot parameter frequency bars in the 
   Parameter Distribution Plot are coloured accordingly.
   • Use Fv/Fm Thresholds of Concern & Use PI Thresholds of Concern. - There  
   are 3 different Thresholds of Concern colours which are used to indicate   
   parameter values falling below 2 defined levels. These levels are defined in the  
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   Display Options dialogue above the Rank Plot Colours section. The 3 colours  
   used are green (indicating values above the Thresholds of Concern values),  
   amber (indicating a value between Threshold of Concern level 1 and 2) and red 
   (indicating a value below Threshold of Concern level 2). These levels only apply to 
   the Fv/Fm and PI parameters. Within the Rank Plot, these colour schemes allow 
   records with lower Fv/Fm and PI values to be easily identified.
   • None. - Rank Plot parameter points are all coloured black.
  D: Rank Plot Data Sorted. This function is unchecked by default. In this state, the  
  Rank Plot parameter points are plotted from left to right across the display area in  
  record number order. Checking this option box will configure the Rank Plot to plot the 
  selected parameter value points in ascending order again from left to right across the 
  screen.
 • Play Speed. - This function is applicable to the graphical analysis screens (Graph,  
  Rank Plot and Spider Plot) in PEA Plus. When multiple data sets have been defined, 
  Graphs, Rank and Spider Plots may be viewed in single or multi-pane viewing modes. 
  In single pane viewing mode, consecutive data sets for each type of plot may be  
  automatically scrolled in a Slide Show. The Play Speed function configures the time 
  each slide remains in view before moving to the next defined data set slide.   
  The Play Speed is set by dragging a slider bar as shown in the image below.

 • Auto Colours. - Automatically assigns the Auto Colours colour scheme to all records 
  in the Summary screen as defined in the Display Options dialogue.
 • Clear Colours. - Removes any colour settings for all records in the Summary screen. 
  All records are assigned black as a colour.
 • Hot Parameters. - Selects 2 parameters which are displayed on the Summary  
  screen. Please refer to the Hot Parameters section for further information.
 • Manage Sets. - Selecting this option opens the Manage Sets dialogue window.  
  Please refer to the Managing Sets section for information regarding this function.

The View and Window drop down menu’s contain standard Windows® functions which 
configure the way in which the PEA Plus Window is displayed. For further information, 
please consult the appropriate sections of the Windows® Help and Support files which can 
be found installed locally on your PC.

The Help menu provides access to the main title page of this document and information 
regarding the PEA Plus version number.
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The Toolbar.

The PEA Plus Toolbar consists of buttons linking to the most commonly used functions of 
the program and can be grouped into several different sections according to functionality.

A: File Handling. 
This group consists of 3 buttons, New File, Open File and Save File. These functions are 
standard Windows® operations common to all programs running in a Windows® 
environment. For details on these functions, please refer to the Windows® Help and 
Support files on your PC.

B: Record/File Movement.
This group consists of Cut, Copy and Paste record buttons. These functions operate in a 
similar manner to the standard Windows® functions of the same name. However, any 
records that are cut or copied may only be pasted within PEA Plus. They are not copied to 
the Windows® Clipboard and as such are unavailable to paste into external applications. 
These functions may be used to place required records into new files.

C: Print.
This function sends the current view to the Windows® Print routine. The standard 
Windows® Print dialogue will be opened allowing specific printers and associated options 
to be configured.

D: Record Download.
This category consists of 2 buttons. The green button initiates a download from a Handy 
PEA (please refer to the Transferring Data from Handy PEA section for further details) and 
the blue button initiates a download from the Pocket PEA (please refer to the Transferring 
Data from the Pocket PEA section).

E: Data Set Configuration & Selection.
This group of buttons allow configuration of new data sets and selection and editing of 
previously defined data sets in the various data analysis screens. Full details on the 
definition of data sets can be found in the Data Sets section of this document. 

F: Graphical Display Control.
The Graphical Display control buttons allow the viewing modes of the 3 graphical data 
analysis screens (Graph, Rank and Spider Plot) to be altered when multiple data sets have 
been defined. The following descriptions indicate the functionality of each of the buttons.

 Single Pane Viewing Mode. - When in each of the 3 graphical analysis screens, 
clicking this button will display the currently selected records in the Summary screen for a 
selected data set. Different data set records may be displayed by either selecting the 
relevant set number button from the Toolbar, by initiating a slide show of the defined data 
sets (see Slide Show controls below) or by manually scrolling through the available data 
sets using the previous and next arrow buttons on the Toolbar.
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   Multi-Pane Viewing Mode 1. - Selecting either of these buttons will display records 
from up to 4 defined data sets at a time. Clicking the left button will display data sets 1 - 4 
(if defined), the right button will display the remaining sets 5 - 8 (if defined). In multi-pane 
view, changes made to the configuration of either of the graphical analysis tools will be 
global i.e. all data set plots in view will be affected by the configuration changes. Please 
refer to each of the individual analysis screen sections for further information on how data 
is presented in multi-pane viewing mode. Click the any of the following links to proceed to 
the relevant section. Graph Screen Multi-Pane Viewing Mode, Rank Plot Screen Multi-
Pane Viewing Mode or Spider Plot Screen Multi-Pane Viewing Mode.

 Multi-Pane Viewing Mode 2. - Selecting this button from the Toolbar displays all 
selected records from all defined data sets simultaneously. As with multi-pane viewing 
mode 1, any changes made to the configuration settings of the graphical analysis screen 
when in this viewing mode are global. The image below shows an example of the Spider 
Plot screen in this viewing mode.
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  Data Set View Scroll Buttons. - When in single pane viewing mode, these arrow 
buttons allow manual scrolling through any defined data set plots/graphs.

  Data Set Slide Show Controls. - These Pause/Play buttons allow plots/graphs of 
defined data sets to be scrolled automatically in a slide show type format. Each slide is 
displayed by default for 2 seconds before automatically advancing to the next data set. 
This duration may be configured to up to 20 seconds (please refer to the Play Speed 
section of the Tools drop down menu option). 

G: About PEA Plus.
Clicking this button displays a dialogue box containing PEA Plus version details.

PEA Plus Protocol Editor.
Handy PEA is able to store up to 5 user-defined measurement protocols internally for 
activation in the field. The protocols are created in the PEA Plus Protocol Editor application 
and uploaded to the Handy PEA via the RS232 serial connection. The Protocol Editor is 
accessed from PEA Plus via the Handy PEA drop down menu. The following image shows 
the Protocol Editor main interface.

This image shows a user defined protocol intended to allow simple measurements of    
Fv/Fm. The Protocol Editor application consists of 2 sections; the configuration panel and 
the protocol report. 

Protocols may consist of single or multiple (up to 20) recordings. In addition, these 
protocols may be configured to repeat at user-defined intervals. The following sections 
provide guidelines on creating protocols for upload to the Handy PEA.
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Protocol Configuration Panel.

 Title. 
Up to 15 alpha-numeric characters may be defined for the title of the protocol. This is the 
text that will be displayed in the Protocol Selection screen on the Handy PEA itself (please 
refer to the Protocol Selection section in the Handy PEA chapter of this document for more 
information).

 Gain.
Handy PEA is able to apply up to x10 amplification to a recording allowing fluorescence 
kinetics to be measured from samples with low chlorophyll content (please refer to the 
Protocol section in the Handy PEA chapter for instructions on setting the gain in Handy 
PEA). Protocols may be defined to use a particular required gain level or to perform an 
Autogain function prior to taking the first record in the protocol. Autogain is an integral 
function of the Handy PEA control unit and details on the implementation of Autogain may 
be found in the Autogain section of the Handy PEA chapter.

 Single Recording.
Single recording should be selected if only one recording is required for the protocol. Once 
this option is selected, click the                          button to configure additional elements to 
the recording. 

3 different actions may be configured before the actual recording occurs.
 • No Action. - Take no additional action pre-recording.
 • Dark Adaptation Period. - Selecting this option will configure Handy PEA to pause for 
   a user-defined period of time before initiating the recording.
 • Pre-illumination Period. - Selecting this option allows the addition of a user-defined  
   period of actinic illumination of a selectable intensity (up to approx. 3500µmols m-2 s-1) 
   before the recording is taken.
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The final element of configuration for single recording is the duration and intensity of the 
recording itself. A single record may be between 0.1 and 300 seconds in duration at an 
intensity of up to approx. 3500 µmols m-2 s-1.

 Multi Recording.
When selecting the Multi Recording option, the Protocol 
Editor displays a dialogue allowing the required number of 
recordings to be entered. Protocols may contain up to 20 
individual recordings.

Once the number of required recordings has been defined, 
PEA Plus will automatically open the setup dialogue allowing periods of dark adaptation or 
illumination of user-definable intensity to be configured before each recording. Duration 
and intensity of the individual recordings themselves may also be configured from the 
dialogue as shown in the image below.

The dialogue is arranged into 3 different groups with the number of individual recordings 
selected displayed in the top section (this number may be altered by entering the required 
number of recordings or by using the spin box controls to select the required number). 

The middle section of the window controls the duration and actinic light intensity of pre-
recording events. These events may be up to 100 seconds of either actinic illumination or 
dark adaptation. The pre-recording event is configured via a simple table with recording 
number on the top row and corresponding illumination intensity on the bottom row 
(intensities may be any value up to the maximum intensity of the Handy PEA sensor which 
is approx. 3500µmols m-2 s-1). The required pre-illumination intensity is set either by 
manually inserting the intensity value into the relevant box. Should dark-adaptation periods 
be required before all recordings, set all illumination value boxes to 0. In order to set 
illumination intensities, either manually type the required values into the relevant boxes or 
select the Auto Fill button which displays the following window.
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Enter the required intensity for the events before the first and second recordings into the 
Recording Number 1 and Recording Number 2 spin boxes. Enter an increment value in 
order to assign increasing pre-illumination intensities to the remaining recordings in the 
protocol. If equal intensities are required for each pre-illumination stage, enter identical 
values into the Recording Number 1 and Recording Number 2 spin boxes and an 
increment value of 0. Confirmation of the pre-illumination settings are displayed in the 
lower portion of the dialogue. In the example above, the protocol contains 10 recordings 
with pre-illumination values increasing by 250 µmols m-2 s-1 on each measurement 
providing a light response type experiment for the sample. Pressing OK will enter the 
values into the Multi Recordings dialogue.

The bottom section of the Multi Recording configuration dialogue allows duration and light 
intensity of the recording to be defined. Recording duration is identical for each 
measurement in the protocol and may be between 0.1 and 300 seconds at intensities up 
to approx. 3500 µmols m-2 s-1 (or the maximum achievable by the Handy PEA). An Auto 
Fill function is also present for the measurement stage configuration. By entering an 
intensity value in to the dialogue box as shown in the image below, all records in the 
protocol will be assigned identical measurement intensities. Variations to the measurement 
intensity should be type manually into the relevant box.

 Repeats.
The Repeat function allows the protocol to be cycled over a defined time interval in order 
to perform up to 1000 individual measurements (the maximum number of recordings held 
by Handy PEA) from only one button press. For example, a protocol consisting of 20 
individual recordings may be repeated up to 50 times in order to completely fill the Handy 
PEA memory (1000 measurements). Alternatively, a single measurement protocol can be 
set to repeat up to 1000 times. 

A Repeats configuration box is used to define the 
number of repeats required and the interval between 
each repetition. The minimum repeat time is calculated 
by the Protocol Editor as the time required to execute all 
pre-illumination and recording events defined. This 
minimum repeat time is displayed in the dialogue box as 
shown in the image opposite. This duration includes the 
time required for the defined protocol to be performed 
and can be used to set a dark adaptation period 
between protocols. At the base of the dialogue, the total 
time for the entire experiment is indicated.
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This function is particularly useful for measuring diurnal changes of plants in greenhouses 
or in the lab. Using long time intervals, Handy PEA can be set to perform ongoing 
measurements over periods exceeding 60 days. Please note that the Handy PEA should 
be operated from the mains charger during assays of long periods of time. 

 Upload.
Clicking this button allows the defined protocol to be uploaded to an available protocol slot 
in the Handy PEA memory. In order to perform the upload, the Handy PEA must be in PC 
Mode and connected to the PC via the RS232 serial connection. Please refer to the 
Establishing an RS232 Connection section for further details. 

Once the protocol has been uploaded to the Handy PEA, it may be selected for use from 
the System > Protocol menu on the control unit. Please refer to the Protocol section of the 
Handy PEA chapter for further information on selecting protocols for use.

Selecting the Handy PEA Status option from the Protocol Editor View drop down menu will 
display a window containing details of protocols currently held in the Handy PEA memory. 
In addition, the dialogue will indicate if any measurements in the Handy PEA memory were 
made with the relevant protocol. The term Used will appear in the status column if records 
can be attributed to the corresponding protocol. 
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Chapter 5
PEA Plus Mobile 

Software



Introduction to PEA Plus Mobile.
Overview.

PEA Plus Mobile software has been written exclusively for the Pocket PEA fluorimeter and 
as such, this chapter bares no relevance to Handy PEA users.

PEA Plus Mobile is a utility designed for use on Pocket PC’s / PDA’s such as a HP IPAQ 
running Windows Mobile 5.0®. It enables records from Pocket PEA to be downloaded via 
a Bluetooth connection for viewing purposes only. Analysis of Pocket PEA records must 
be performed in PEA Plus software on a Windows® desktop or notebook PC.

Bluetooth Connectivity.

Different devices have different methods which must be followed in order to establish 
Bluetooth Serial Connections between 2 devices. The relevant manufacturers installation 
procedure must be followed in order to correctly establish a Bluetooth Wireless 
connection. 

During the Bluetooth connection setup procedure, you will be asked to enter a PIN code. 
This code is programmed into the Pocket PEA and is displayed when the instrument is 
switched on. The code is different for each Pocket PEA instrument and is required by the 
Mobile PC if communications are to be established. 

Installing PEA Plus Mobile on a Mobile PC.
PEA Plus Mobile software is installed on a mobile PC running Windows Mobile 5.0®. In 
order to install the software Microsoft ActiveSync 4.0® or better must be installed on the 
desktop PC. A copy of this program is included on the PEA Plus CD ROM.

To install PEA Plus Mobile, place the PEA Plus CD ROM in the CD tray of the desktop PC. 
The CD will autorun and display a PEA Plus Installation Options Menu. Select Install PEA 
Plus Mobile from this menu. Follow the onscreen prompts from the installation Wizard.

Once the installation Wizard has completed successfully, the PEA Plus Mobile software 
will be installed on the mobile PC when it is next connected to the desktop via 
ActiveSync®. A link to the program may be found in the Start menu of the mobile PC.

Also installed is the example data file which has been used throughout this manual in 
order to highlight functionality of the PEA Plus software application. This file installed in the 
My Documents directory of the mobile PC in a sub-directory called Hansatech. To open 
this file within PEA Plus Mobile, run the program an select File > Open from the Menu 
button. Select Example Data File.pcs from the files list to view the example file.
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Operating PEA Plus Mobile.
Using PEA Plus Mobile to Configure Pocket 
PEA.

As mentioned in the Pocket PEA chapter, limited 
configuration options are available on the fluorimeter 
itself. PEA Plus or PEA Plus Mobile software must be 
used to set recording duration (1, 3 or 10 seconds) and 
recording light intensity (up to a maximum of 3500 
µmols m-2 s-1) via a Bluetooth wireless connection. 

To configure the Pocket PEA, run the PEA Plus Mobile 
application and select Menu > Pocket PEA > Setup 
from the Menu button in the bottom left of the screen. If 
a successful Bluetooth connection is available, the 
opposite screen will be displayed.

Measurement duration of either 1, 3 or 10 seconds may 
be selected.

To set the recording illumination intensity of the LED, 
click the minus sign to reduce or the plus sign to 
increase the intensity until the required value is 
displayed. Click OK to send the configuration settings 
to the Pocket PEA.

Transferring Data from Pocket PEA.

To transfer data from the Pocket PEA, an active 
Bluetooth wireless communication between the Mobile 
device and the Pocket PEA must be available. 

From the PEA Plus Mobile menu, select Pocket PEA > 
Download All. If a Bluetooth connection is connected, 
all records in the Pocket PEA memory will automatically 
be downloaded. When the download is complete, PEA 
Plus Mobile saves the record set with a *.PCS file 
extension with the filename indicating the date and time 
of the download. In the diagram opposite, the download 
took place on 12th December 2006 at 14.26 hours and 
18 seconds.

Clicking the OK button automatically places all 
downloaded records into the PEA Plus Mobile 
Summary screen. Downloads may also be activated by 
tapping the      icon on the toolbar at the bottom of the 
screen.
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PEA Plus Mobile Data Display Screens.
Summary Screen.

The Summary Screen in PEA Plus Mobile serves a 
similar purpose to the Summary Screen in PEA Plus 
software. Individual or multiple records may be selected 
to plot on the Graph display screen or to be viewed in 
the Parameter Display screen.

To select or un-select individual records using the 
Mobile PC’s stylus, tap and hold the relevant record 
row. Alternatively, all files in the Summary Screen may 
be selected or un-selected by choosing Edit > Select All 
or Edit > Select None respectively from the PEA Plus 
Mobile menu. Selected files are indicated by a beige 
coloured highlight; un-selected files are greyed out.

When the files are initially downloaded into PEA Plus 
Mobile, colours are assigned to individual records by 
default. These colours are used by the Graph Screen 
as trace colours for individual records. This setting is 
located in the Tools > Options screen accessed from 
the Menu button in the bottom left. Un-checking the 
Automatic on Download option assigns all records a 
black colour when records are downloaded. These 
colours may not be edited in PEA Plus Mobile. 
However, assigned colours may be amended when the 
data is transferred into PEA Plus on a standard 
Windows® PC or notebook.

Graph Screen.

The Graph Screen plots all records selected in the Summary Screen on a logarithmic axis. 
For optimum display capability, the graph is plotted in landscape mode. The Graph Screen 
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is intended as a tool allowing traces to be checked for spurious data in the field. The only 
options available for the Graph Screen are the facilities to show/hide the grid and timemark 
lines. These options are available by selecting Tools > Options from the Menu button.

No further functionality is available for fluorescence traces until the records are transferred 
to the PEA Plus application.

Parameters Screen.

The Parameters Display screen shows calculated 
parameter values from any records selected in the 
Summary Screen. All calculated parameters for 
individual records including measurement duration and 
LED intensity used for the recording are displayed on a 
single page. 

Consecutive/previous selected record parameters may 
be viewed by tapping the plus/minus buttons at the top 
of the screen respectively.

ID references may be added to individual records 
which are displayed in the Parameters Screen adjacent 
to the Record number. ID’s are entered from the Edit > 
ID option selected from the Menu button.

Toolbar & Menu System.
Toolbar.

 A: Opens the PEA Plus Mobile menu system.
 B: Displays the Summary Screen.
 C: Plots all records selected in the Summary Screen in the Graph Screen display.
 D: Displays calculated parameters one record at a time from all records selected in the 
   Summary Screen.
 E: Views any comments that have been defined for the file set.
 F: Initiates the download of all records from Pocket PEA.
 G: Displays version information for PEA Plus Mobile.
 H: Opens the system keyboard on the PDA allowing text to be entered in certain  
   locations.
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Menu System.

Clicking the Menu button in the bottom left corner of the screen allows access to various 
options within PEA Plus Mobile as described below.

 Files Menu.
 Open. - Opens previously saved files from the PDA memory.
 Save. - Saves changes made to currently open file set.

 Edit Menu.
 ID. - Allows text ID references of up to 6 alphanumeric characters to be assigned to 
 individual records.
 Comment. - Allows descriptive comments to be added to a file set. Comments may 
 consist of up to 4 lines of 35 characters.
 Select All. - This option is only active when the Summary Screen is displayed. All 
 records in the file set are automatically selected.
 Select None. - As with the Select All option, Select None is only active when the 
 Summary Screen is displayed. All records in the file set are automatically un-selected.

 Pocket PEA Menu.
 Setup. - Allows the recording duration and intensity to be configured on the Pocket 
 PEA. This option requires an active Bluetooth connection.
 Download All. - Downloads all records from the Pocket PEA via a Bluetooth wireless 
 connection.
 Erase All. - This option also requires an active Bluetooth connection. Erases all records 
 currently held in the Pocket PEA memory.

 Tools Menu.
 Options. - There are 2 sets of options within PEA Plus Mobile. The first option allows 
 trace colours to be automatically assigned to individual records at the point of 
 download. The second set of options is concerned with the Graph Screen axes. Grid 
 and timemark lines may be shown/hidden from view. 
 Hot Parameters. - Allows selection of 2 calculated parameters for display in the 
 Summary Screen. All calculated parameters are available for selection.
 About PEA Plus Mobile. - Displays version information.

 View Menu.
 Summary. - Displays the Summary Screen.
 Graph. - Displays the Graph Screen with any selected records plotted.
 Parameters. - Displays the Parameters Screen for individual records selected in the 
 Summary Screen.
 Comment. - Displays any comment that has been defined for the current file set.
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Transferring File Sets to a PC.
File sets may be transferred to the PC either by downloading directly from Pocket PEA into 
PEA Plus software or by copying the saved *.PCS files from the PDA to a PC. This can be 
achieved by the preferred method of communication between a PC and PDA. Microsoft 
ActiveSync via Bluetooth or hard connection, a Bluetooth File Transfer Service, USB hard 
wire connection or a docking cradle (if supplied with the PDA) may all be used.

Please refer to the PDA manufacturers guidelines for details on file transfer to a PC.

Once the files have been transferred to a Windows® PC, files may be opened directly in 
PEA Plus software for data analysis and export to external analysis applications.

84

mailto:info@hansatech-instruments.com
http://www.hansatech-instruments.co.uk


Support Information.
Purchasers of Hansatech Instruments Ltd products can be assured 
of ongoing support and prompt and efficient attention to enquiries 
at all times. 

All products supplied by Hansatech Instruments are guaranteed for 
12 months from the time of despatch against manufacturing faults 
or defective materials. The guarantee does not cover damage 
caused by misuse or unauthorised attempts to repair. 

If difficulties are experienced with the equipment, please contact 
Hansatech Instruments for advice. If necessary, equipment may be 
returned for repair/replacement during the warranty period. No 
charge will be made for parts/labour under warranty but we reserve 
the right to charge for customs clearance and return carriage if 
appropriate. 

For repairs outside of the warranty period, please contact us at the 
address below for an estimate of cost and instructions regarding 
the return of equipment. 

If the product was purchased via a distributor, please contact them 
for advice in the first instance.

Narborough Road, Pentney, King’s Lynn,
Norfolk PE32 1JL England.

Tel: +44 (0)1760 338877      Fax: +44 (0)1760 337303
Email: info@hansatech-instruments.com

Web site: http://www.hansatech-instruments.com
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